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Introduction

Cisco Finesse is a next-generation agent and supervisor desktop designed to provide a collaborative experience
for the various communities that interact with your customer service organization. It helps improve the customer
experience while offering a user-centric design to enhance customer care representative satisfaction as well.

Cisco Finesse provides:

* A browser-based administration console and a browser-based desktop for agents and supervisors; no
client-side installations required.

* A single, customizable "cockpit", or interface, that gives customer care providers quick and easy access
to multiple assets and information sources.

* REST APIs that simplify the development and integration of value-added applications and minimize the
need for detailed desktop development expertise.
Finesse configuration changes are permitted on only the primary server. Access to Finesse administration
console on the secondary server is read-only.

When you attempt to save the changes in Finesse administration console on the secondary node, you receive
a message that administration on the secondary node is read-only.

Cisco Finesse Administration Console

Getting Started

This chapter describes the interfaces that you use to configure, administer, and maintain Cisco Finesse and
describes how to access them.
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Administration Tools

Cisco Finesse Administration Console

The Cisco Finesse administration console is a web-based interface used to configure system settings in Cisco
Finesse. The administration console contains tabs that you click to access the various administration features.
The tab names and the tasks that you can perform on each tab are as follows:

* Settings: IP Phone Agent Settings.

« Call Variables L ayout: Manage the call variables and ECC variables that appear on the agent desktop
call control gadget.

* Desktop Layout: Make changes to the default desktop layout for agents and supervisors.
» Phone Books: Add, edit, or delete phone books or phone book contacts.
* Reasons: Add, edit, or delete Not Ready reason codes, Sign Out reason codes, or Wrap-Up reasons.

» Team Resour ces: Assign desktop layouts, phone books, reason codes, and wrap-up reasons to specific
teams.

» Workflows: Create and manage workflows and workflow actions.

The features you configure in the administration console are case-sensitive. For example, you can create two
workflows named WORKFLOW and workflow or two phone books named BOOK and book.

Sign In to Cisco Finesse Administration Console
You can access the Cisco Finesse administration console only through HTTPS.

When you sign in to Finesse, always use the fully qualified domain name (FQDN) of the Finesse server in
the URL, not the server IP address or hostname.

Procedure

Step 1 Direct your browser to https://FQDN: 8445/cfadmin, where FQDN is the fully qualified domain name of your
primary server.

Step 2 The first time you access the administration console using HTTPS, you are prompted to trust the self-signed
certificate provided with Finesse. The following table describes the steps for each supported browser.

Note If you are using HTTP to access the administration console, this step is not required.

If you are using HTTPS but have installed a CA Certificate, you can skip this step. For more
information about installing a CA Certificate, see the Cisco Finesse Installation and Upgrade Guide.

Option Description

Ifyouuse Internet | a. A page appears that states there is a problem with the website's security certificate.
Explorer: Click Continueto thiswebsite (not recommended). This action opens the sign in
page for the administration console. A certificate error appears in the address bar of
your browser.

b. Click Certificate Error, and then click View Certificates to open the Certificate
dialog box.
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Option Description

C. In the Certificate dialog box, click Install Certificate. This action opens the
Certificate Import Wizard.

d. Click Next.

e. Select Place all certificatesin thefollowing store, and then click Browse.
f. Select Trusted Root Certification Authorities, and then click OK.

g. Click Next.

h. Click Finish.

i. IfaSecurity Warning dialog box appears that asks if you want to install the certificate,
click Yes.

A Certificate Import dialog box appears that states the import was successful.

j. Click OK.

Ifyou use Firefox: |a. A page appears that states this connection is untrusted.
b. Click | Understand the Risks, and then click Add Exception.

C. Inthe Add Security Exception dialog box, ensure the Permanently store this
exception check box is checked.

d. Click Confirm Security Exception.

Step 3 On the Sign-In page, in the ID field, enter the Application User ID that was established during the installation.
Step 4 In the Password field, enter the Application User password that was established during the installation.
Step 5 Click Sign In.

A successful sign-in launches an interface with defined administration gadgets and a Sign Out link.

\}

Note After 30 minutes of inactivity, Finesse automatically signs you out of the administration console and
you must sign in again.

Account Locked After Five Failed Sign In Attempts

If an administrator tries to sign in to the Finesse administrator console (or diagnostic portal) with the wrong
password five times in a row, Finesse blocks access to that user account for a period up to 30 minutes. For
security reasons, Finesse does not alert the user that their account is locked. They must wait 30 minutes and
try again.

Similarly, if agents or supervisors sign in to the desktop five times in a row with the wrong password, Finesse
blocks access to that user account. However, in this case, the lockout period is only 5 minutes. This restriction
also applies when agents and supervisors sign in using the mobile agent or Finesse IP Phone Agent (IPPA).

Cisco Finesse .
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\)

Note When an agent or supervisor account is locked, subsequent attempts to sign in, even with correct

credentials, reset the lockout period to 5 minutes again. For example, if a locked user tries to sign in
again after only 4 minutes, the lockout period is reset and the user must wait another 5 minutes. This
reset does not apply to the administrator account.

To view whether a user account is locked, enter the following CLI command:
file get activelog desktop recurs compress

Then extract the zipped output, and search the catalina.out logs (/opt/cisco/desktop/finesse/logs/catalina.out)
for the following message referring to the locked username:

An attempt was made to authenticate the locked user "<username>"

Sign In to Cisco Unified Communications Operating System Administration

Step 1

Step 2

Procedure

Direct your browser to https://FQDN:8443/cmplatform, where FQDN is the fully-qualified domain name of
your server.

Sign in with the username and password for the Administrator User account.

Note After you sign in, you can access other Unified Communications Solutions tools from the Navigation
drop-down list.

Certificate Management

Finesse provides a self-signed certificate that you can use or you can provide a CA certificate. You can obtain
a CA certificate from a third-party vendor or produce one internal to your organization.

Finesse does not support wildcard certificates. After you upload a root certificate signed by a Certificate
Authority, the self-signed certificates are overwritten.

If you use the Finesse self-signed certificate, agents must accept the security certificates the first time they
sign in to the desktop. If you use a CA certificate, you can accept it for the browser on each client or deploy
a root certificate using group policies.

\)

Note Ifthere is a mismatch between the server hostname and the hostname in the certificate, a warning message

is displayed in the IE browser about certificate address mismatch. The certificate must be re-generated
so that the hostname in the certificate matches the server hostname before importing to Finesse. If there
is a valid reason for the mismatch, you can uncheck the Warn about certificate address mismatch

checkbox from Tools> | nternet Options> Advanced > Security to allow the certificate to be accepted.
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Obtain and Upload CA Certificate

Step 1

Step 2

Step 3

Step 4

Step 5
Step 6

Step 7

\)

Note  This procedure is optional. If you are using HTTPS, you can choose to obtain and upload a CA certificate
or you can choose to use the self-signed certificate provided with Finesse.

To eliminate browser security warnings each time you sign in, obtain Finesse certificate signed by a Certificate
Authority (CA). Use the Certificate Management utility from Cisco Unified Communications Operating
System Administration.

To open Cisco Unified Communications Operating System Administration, enter the following URL in your
browser:

https://hostname of primary UCCX server/cmplatform

Sign in using the username and password for the Application User account created during the installation of
Unified CCX.

Procedure

Generate a CSR.

a) Select Security > Certificate Management > Generate CSR.
b) From the Certificate Name drop-down list, select tomcat.

¢) Click Generate CSR.

You must not download the ECDSA certificate.

Download the CSR.

a) Select Security > Certificate Management > Download CSR.
b) From the Certificate Name drop-down list, select tomcat.
¢) Click Download CSR.

Generate and download a CSR for the secondary Unified CCX server.

To open Cisco Unified Operating System Administration for the secondary server, enter the following URL
in the address bar of your browser:

https://hosthame of secondary UCCX server/cmplatform
Use the CSRs to obtain the CA root certificate, intermediate certificate, and signed application certificate
from the Certificate Authority.

Note To set up the certificate chain correctly, you must upload the certificates in the order described in
the following steps.

When you receive the certificates, select Security > Certificate Management > Upload Certificate.
Upload the root certificate.

a) From the Certificate Purpose drop-down list, select tomcat-trust.

b) In the Upload File field, click Browse and browse to the root certificate file.

c¢) Click Upload File.

Upload the intermediate certificate.

Cisco Finesse .
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Step 8

Step 9

Step 10

Step 11

a) From the Certificate Purpose drop-down list, select tomcat-trust.
b) In the Upload File field, click Browse and browse to the intermediate certificate file.
¢) Click Upload File.

Upload the application certificate.

a) From the Certificate Purpose drop-down list, select tomcat.

b) Inthe Upload File field, click Browse and browse to the application certificate file.
¢) Click Upload File.

After the upload is complete, restart the Cisco Unified CCX server on the primary node.

Note Delete the self-signed certificates from the clients certificate store. Then close the browser, relaunch,
and reauthenticate.

Upload the application certificate to the secondary Cisco Unified CCX server.

You do not need to upload the root and intermediate certificates to the secondary Unified CCX server. After
you upload these certificates to the primary server, they are replicated to the secondary server.

Restart the Cisco Unified CCX server on the secondary node.

Client-Side Certificate Acceptance

The procedures that agents must perform to accept certificates the first time they sign in depends on the method
you choose to manage certificates and the browser used by the agents.

Related Topics
Set Up Certificates

Trust Self-Signed Certificate

Step 1

Step 2

Trust the self-signed certificate provided by Finesse to eliminate browser warnings each time you sign in to
the administration console or agent desktop.

If you uploaded a CA certificate, you can skip this procedure.

Procedure

In your browser, enter the URL for the administration console (https://FQDN of primary
server:portnumber/cfadmin) or the agent desktop (https://FQDN of primary server).

Perform the steps in the following table for the browser you are using.

Option Description

If you use a. A page appears that states there is a problem with the website's security certificate. Click
Internet Continueto thiswebsite (not recommended). This action opens the sign in page for
Explorer: the administration console (or agent desktop). A certificate error appears in the address

bar of your browser.

b. Click Certificate Error, and then click View Certificatesto open the Certificate dialog
box.

. Cisco Finesse


uccx_b_ccx-admin-and-operations-guide_chapter11.pdf#nameddest=unique_199

| Cisco Finesse

Trust Self-Signed Certificate .

Option Description
¢. In the Certificate dialog box, click I nstall Certificate. This action opens the Certificate
Import Wizard.
Note If you use Internet Explorer 11, you must add Finesse to your trusted sites
before the Install Certificate option appears (I nternet Options> Security >
Trusted Sites> Sites).
After you click Install Certificate, under Store L ocation, select Current
User to install the certificate for the current user only, or select L ocal M achine
to install the certificate for all Windows users who use this computer.
d. Click Next.
e. Select Placeall certificatesin the following store, and then click Browse.
f.  Select Trusted Root Certification Authorities, and then click OK.
g. Click Next.
h. Click Finish.
i. Ifa Security Warning dialog box appears that asks if you want to install the certificate,
click Yes.
A Certificate Import dialog box that states the import was successful appears.
j. Click OK.
k. Enter your credentials, and then click Sign In.
If you use a. A page appears that states this connection is untrusted.
Firefox:
Click I Understand the Risks, and then click Add Exception.
c. Inthe Add Security Exception dialog box, ensure the Per manently storethisexception
check box is checked.
d. Click Confirm Security Exception.
The page that states this connection is untrusted automatically closes and the
administration console (or agent desktop) loads.
e. Enter your credentials, and then click Sign In.
f.  For the agent desktop only, an error appears that states Finesse cannot connect to the

Cisco Finesse Notification Service and prompts you to add a security exception for the
certificates issued by the Finesse server.

Click OK.

Cisco Finesse .
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Add Certificate for HTTPS Gadget

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6

Add a certificate for a secure HTTP (HTTPS) gadget to allow the gadget to load into the Finesse desktop and
successfully perform HTTPS requests to the Finesse server.

This process allows HTTPS communication between the Finesse gadget container and the third-party gadget
site for loading the gadget and performing any API calls that the gadget makes to the third-party server.

\)

Note A gadget that loads using HTTPS may still use HTTP communication between that gadget and the
application server where it resides. If all traffic must be secure, the gadget developer must ensure that
HTTPS is used to make API calls to the application server.

The certificate must be signed with a common name. The gadget URL in the desktop layout must use the
same name (whether it uses an IP address or a fully qualified domain name) as the name with which the
certificate is signed. If the certificate name and the name in the gadget URL do not match, the connection is
not trusted and the gadget does not load.

To find the certificate name, enter the gadget URL in your browser. Click the lock icon in the address bar and
then click View Details. Look for the common name field.

The Finesse host must be able to resolve this name using the DNS host that was entered during installation.
To verify that Finesse can resolve the name, run the CLI command “utils network ping <hostname>"".

Procedure

Download the tomcat.pem certificate from the third-party gadget host.
Upload the certificate to the designated Finesse system.

a) Sign in to Cisco Unified Operating System Administration on the primary Unified CCX node
(https://FQDN/cmplatform, where FQDN is the fully qualified domain name of the Unified CCX node).

b) Click Security > Certificate M anagement.

¢) Click Upload Certificate/Certificate Chain.

d) From the Certificate Name drop-down list, select tomcat-trust.

e) Click Browse and navigate to the tomcat.pem file that you downloaded in the previous step.
f) Click Upload File.

Restart Cisco Tomcat on the primary Unified CCX node.
Restart Cisco Finesse Tomcat on the primary Unified CCX node.
After synchronization is complete, restart Cisco Tomcat on the secondary Unified CCX node.

Restart Cisco Finesse Tomcat on the secondary Unified CCX node.

Add Certificate for Multi-session Chat and Email

Add the SocialMiner certificate to the Unified CCX servers to allow communication between SocialMiner
and Finesse. After you complete this procedure, agents must accept certificates in the Finesse desktop before
they can use this gadget.

If SocialMiner is deployed with private certificates, agents cannot join chat rooms or reply to email messages
until they accept the SocialMiner certificates. If the Manage Chat and Email gadget is deployed on the Manage
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Chat and Email tab of the Finesse desktop, agents may not realize that they need to accept the certificates.
Have agents check the tab where the gadget appears when they sign in to Finesse to make sure that certificates
are all accepted and the gadget loads correctly.

The steps to add a certificate for the Manage Chat and Email gadget are the same as the steps outlined in the
procedure Add Certificate for HTTPS Gadget.

N

Note The procedure to add a certificate for an HTTPS gadget refers to the third-party gadget host. To add a
certificate for chat and email, perform the applicable steps on the SocialMiner server.

Related Topics
Add Certificate for HTTPS Gadget, on page 8

Manage System Settings
A\

Note For information about Finesse IP Phone Agent Settings, see M anage Finesse | P Phone Agent.

Related Topics
Manage Finesse IP Phone Agent, on page 62

Context Service Settings

Cisco Context Service is a cloud-based omnichannel solution for Cisco Unified Contact Center Express. It
enables you to capture your customer’s interaction history by providing flexible storage of customer-interaction
data across any channel.

Context Service works out of the box with Cisco Customer Collaboration products. Context Service also
provides an SDK interface for integration with your own applications or third-party applications to capture
end-to-end customer-interaction data.

For more information about Context Service and to check service availability, see https://help.webex.com/
community/context-service.
Context Service Network Connectivity Requirements

Context Service is a cloud-based service and requires that call center components using Context Service to
be able to connect to the public Internet.

Context Service uses port 443 (HTTPS).

The following URLs must be added to allowed list in your firewall so that your contact center components
can connect to, and receive data from Context Service.

* * . webex.com
® * . wbx2.com

® *.ciscoccservice.com

Cisco Finesse .
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\)

Note Use wildcard URLs in your allowed list because Context Service is accessed through multiple subdomains.
Context Service subdomain names can dynamically change.

If you register Context Service by enabling the proxy setting option, configure the browser proxy with the
URL specified in the Context Service Management Gadget. Refer to the following links to configure the proxy
settings for the related browsers.

Chrome https://support.google.com/chrome/answer/96815?hl=en

Firefox https://support.mozilla.org/en-US/kb/
advanced-panel-settings-in-firefox

Internet Explorer http://windows.microsoft.com/en-in/windows/
change-internet-explorer-proxy-server-settings#1TC=windows-7

Register and Configure Context Service

Step 1

Step 2
Step 3

Registering applications with Context Service is easy if your Cisco Webex Control Hub account has been
entitled for Context Service.

For Cisco Context Center on-premise applications, simply use the built-in registration process. A browser
window displays and prompts you to log in to Cisco Webex Control Hub. Log in and follow the on-screen
instructions to authorize the application to connect to Context Service.

Use the Context Service Management gadget to register Unified CCX with the Context Service.

Before you begin
Ensure that your web browser allows popups.

When your organization is entitled for Cisco Context Service, you must have received an email requesting a
sign-in and a password change. Sign in using the registration email, and change the password. Now your
organization is entitled to use Context Service.

If the browser requires a proxy to connect to internet, configure the browser to use proxy. See the browser
documentation about configuring proxy.

Procedure

Verify the Context Service parameters as specified on the System Parameter s Configuration Web Page.
If Unified CCX server has to access Context Service via HTTP proxy, configure the proxy parameters and
select proxy type as HTTP .

If you are not already signed in, sign in to the Cisco Finesse Administration console.

To register Unified CCX with the Context Service, in the Context Service Management gadget, click
Register. For more information about Context Service registration, see https://help.webex.com/community/
context-service.

Note If the Unified CCX FQDN is not added as an exception in the blocked popup window settings of
the browser, the opened registration and deregistration popup windows do not close automatically.
You must manually close the popup windows.
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Step 4 You are prompted to log in and enter your Cisco Webex Control Hub admin credentials to complete the
registration.

Note If you encounter any issues with the Context Service connectivity and would want to reregister or
troubleshoot the issue, click Deregister.

During the Registration process, at any time if you wish to cancel the registration, click Cancel. If registration

fails or context service cannot be reached, you can reregister by clicking the Register button.

In case of Context Service failures, you will receive RTMT alerts.

Note If using Firefox, enable the dom.allow_scripts to_close windows config to ensure that any
additional tabs opened for context service registration close as expected. To do this:

a. Enter about:config in the Firefox browser.

b. Click | accept therisk.

€. Search fordom.allow scripts to close windows config.
d. Double click to change the value field to True.

e. Restart your browser.

What to do next

If context service registration is done by enabling the proxy setting option, configure the browser proxy with
the URL specified in the Context Service Management gadget.

Manage Call Variables Layouts

Call Variables Layouts

You can use the Call Variables Layouts gadget to define how call variables appear on the Finesse agent
desktop. You can configure up to 200 unique Call Variables Layouts (one default layout and 199 custom
layouts). As part of this functionality:

* Each layout has a name (required) and description (optional).

+ After an upgrade from a release earlier than Cisco Finesse Release 11.0, Finesse migrates the previously
configured default layout and assigns it the default name (Default Layout) and description (Layout used
when no other layout matches the user layout Custom/ECC Variable).

* You can change the name and description of the default Call Variables Layout.
* You cannot delete the default Call Variables Layout.
* Finesse appends (Default) to the name of the default Call Variables Layout.

» To display a custom Call Variables Layout, in the Unified CCX routing script set the user.layout ECC
variable to the name of a configured Call Variables Layout. In this case, if no custom layouts match the
user.layout value (or no custom layouts are configured), Finesse displays the default layout.
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* Finesse retains the custom layout as specified by the user.Layout ECC variable on CTI server failover.
During PG failover, Finesse changes the active call layout to the default layout while retaining the call
variables and time indicators.

Call Variables

Each Call Variables Layout supports one variable in the header of the call control gadget and up to a total of
20 variables in two columns below the header (up to 10 in each column). You can use call variables, Extended
Call Context (ECC) variables, or the following Outbound Option ECC variables.

* BACampaign

* BAAccountNumber
* BAResponse

* BAStatus

* BADialedListID

* BATimeZone

* BABuddyName

* BACustomerNumber

Columns can be empty.

The administrator can include the following additional fields in the Call Variables Layout. These variables
appear as a drop-down list in the call variable gadget which the admin can assign to a layout.

* queueNumber
* queueName

» wrapUpReason

To enable Outbound Option data to appear in Cisco Finesse, the administrator must edit the Default layout
to include some or all Outbound Option variables.

Configure Call Variables Layouts

Procedure

Step 1 From the Manage Call Variables Layouts gadget:

* To create a new Call Variables Layout, click New.

* To modify an existing Call Variables Layout, choose a layout from the list, and click Edit (or click Delete
to remove it).

Step 2 Under Create New Layout (or under Edit <layout name> when editing an existing layout):

* Enter a name for the Call Variables Layout (maximum 40 characters).

* Enter a description of the Call Variables Layout (maximum 128 characters).

. Cisco Finesse



| Cisco Finesse

Step 3

Step 4

Step 5

Step 6

Configure Call Variables Layouts .

List of Call Variables Layouts

Description
Default Layout (Defauit) Layout used when no other layout matches the user layout Custom/ECC Variable

Create New Layout

Name Custom Description | Custom Layout
Call Header Layout

Account Number callVariable1 |
Call Bedy Left-Hand Column Layout Call Body Right-Hand Column Layout
caliVariabled j * [None Configured]
“Add Row |

e

353499

Under Call Header Layout:

* Enter the display name that you want to appear in the header of the Call Control gadget on the Finesse
desktop, for example, Customer Name (maximum 50 characters).

* From the drop-down list, choose the call variable or Outbound Option ECC variable that you want to
appear in the header, for example, callVariable3 (maximum 32 characters).

In the Call Body Left-Hand Layout and Call Body Right-Hand Layout areas:
a) Click Add Row to add a new row (or click the “X” to delete a row).
b) For each row:

* Enter the display name that you want to appear on the desktop, for example, Customer Name
(maximum 50 characters).

* Enter the corresponding call variable or Outbound Option ECC variable from the drop-down list
(maximum 32 characters).

Click Saveto save the changes, or Cancel to discard the changes.

Note When you modify the Call Variables Layout of the agent desktop, the changes you make take effect
after three seconds. However, agents who are signed in when the changes are made must sign out
and sign back in to see those changes reflected on their desktops.

To view the latest configured Call Variables Layout, click Refresh from the Manage Call Variables Layouts
gadget.

Cisco Finesse .
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Add ECC Variables to Call Variables Layout
A\

Note Cisco Finesse only supports Latinl characters for ECC variables. Other Unicode characters are not
supported. For example, if you add an ECC variable that contains Chinese characters to the call variable
layout, it may not appear correctly on the agent desktop.

Procedure

Step 1 In the header or the row where you want the ECC variable to appear, from the Variable drop-down list, choose
Custom.

The Custom/ECC Variable Entry dialog box appears.

Custom/ECC Variable Entry

user .ecc.myvariable|

Cancel Set

347798

Step 2 In the Custom/ECC Variable Name field, enter the name of the ECC variable you want to appear on the agent
desktop.

Step 3 Click Set.

The ECC variable now appears in the Variable drop-down list for selection.

Assign Call Variables Layouts

Procedure

Step 1 In the CCX Editor's Expanded Call Variables tab, create an ECC variable called user.layout in the Set
Enterprise Call Info Step used in the CCX routing script.

Note If both a user.layout and a user.Layout are specified, Finesse will prioritize user.layout over
user.Layout. If the layout specified in the user.Layout or user.layout is not found, Finesse will use
the Default layout.
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Step 2 Set the value of user.layout to the name of the call variables layout that should be used. The layout name
should match the name of a call variables layout that was created on the Call Variables Layout tab in Finesse
Administration.

Manipulate Call Variables Layouts with a Workflow

You can manipulate the call variables layout that an agent sees when a call is answered by using a workflow.
To do so, configure an HTTP Request workflow action and set the value of the ECC variable user. Layout to
the name of the custom layout to display.

For information about how and when workflows are executed, see Wor kflows and Wor kflow Actions.

For more details, see the section, "Adding an HTTP Request Workflow Action" in the white paper Cisco
Finesse: How to Create a Screen-Pop Workflow.

Related Topics
Workflows and Workflow Actions, on page 53

Manage Desktop Layout
You can define the layout of the Finesse desktop on the Desktop Layout tab.

|

Important Requirements, such as processor speed and RAM, for clients that access the Finesse desktop can vary.
Desktops that receive events for more than one agent (such as agent and supervisor desktops running
Live Data reports that contain information about other agents and skill groups) require more processing
power than desktops that receive events for a single agent.

Factors that determine how much power is required for the client include, but are not limited to, the
following:

* Contact center traffic
+ Additional integrated gadgets in the desktop (such as Live Data reports or third-party gadgets)

* Other applications that run on the client and share resources with the Finesse desktop

Finesse Desktop Layout XML

The Finesse Layout XML defines the layout of the Finesse desktop, including tab names and the gadgets that
appear on each tab.

Use the Manage Desktop Layout gadget to upload an XML layout file to define the layout of the Finesse
desktop for agents and supervisors.

Actions on the M anage Desktop L ayout gadget:
* Finesse Default Layout XML: Expands to show the layout XML for the default Finesse desktop.
* Restore Default Layout: Restores the Finesse desktop to the default layout.

» Save: Saves your configuration changes.

Cisco Finesse .
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* Revert: Retrieves and applies the most recently saved desktop layout.

Default Layout XML

| o

Important  After a system upgrade, the old desktop layout is retained. If you had a modified desktop layout before
upgrade, perform the following steps to ensure you obtain the latest changes:

* Sign in to the Finesse administration console and click the Desktop L ayout tab.
* Copy the desktop layout to a text file.

* On the Manage Desktop Layout gadget, click Restore Default Layout.

* Click Save.

* Using the text file of the desktop layout that you saved before the upgrade as a reference, modify
the layout to include the changes that you made to the previous layout.

* Click Save to save your changes.

If any changes are made to the component IDs or URLs in the default XML layout, the following features
may not work as expected.

\}

Note The components can be rearranged in any order to show on the Finesse desktop.

Feature Component ID URL

Title and Logo cd-logo <url>/desktop/scripts/js/logo.js</url>

Voice State control agent-voice-state <url>/desktop/scripts/js/agentvoicestate.component.js</url>
Non-voice state nonvoice-state-menu <url>/desktop/scripts/js/nonvoice-state-menu.component.js</url>
control

Team Message broadcastmessagepopover | <url>/desktop/scripts/js/teammessage.component.js</url>
Desktop Chat chat <url>/desktop/scripts/js/chat.component.js</url>

Dialer make-new-call-component | <url>/desktop/scripts/js/makenewcall.component.js</url>
Agent identity identity-component <url>/desktop/scripts/js/identity-component.js</url>

Update Default Desktop Layout

When you modify the layout of the Finesse desktop, the changes you make take effect on the desktop after
10 seconds. However, agents who are signed in when the changes are made must sign out and sign back in
to see those changes reflected on the desktop.
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\)

Note The call control gadget is only supported at the page level. You must ensure that the call control gadget
(<gadget>/desktop/gadgets/CallControl.jsp</gadget>) is placed within the <page></page> tag for it to
work correctly. Do not place this gadget within a <tab></tab> tag.

Procedure

Step 1 In the Finesse Layout XML area, make changes to the XML as required.

Example:

If you want to add a new tab called Reports, add the following XML within the tabs tags under the
<role>Agent</role> tag.

<tab>
<id>reports</id>
<label>Reports</label>
</tab>

If you want to add this tab to the supervisor desktop, add the XML within the tabs tags under the
<role>Supervisor</role> tag.

To add a gadget to a tab, add the XML for the gadget within the gadgets tag for that tab.

<gadgets>
<gadget>http://<ipAddress>/gadgets/<gadgetname>.xml</gadget>
</gadgets>

Replace <ipAddress> with the IP address of the server where the gadget resides.

If you want to add multiple columns to a tab on the Finesse desktop, add the gadgets for each column within
the columns tags for that tab. You can have up to four columns on a tab.

<tab>
<id>tab-id</id>
<label>Tab Label</label>
<columns>
<column>
<gadgets>
<gadget>/gadget/1l/url.xml</gadget>
<gadget>/gadget/2/url.xml</gadget>
</gadgets>
</column>
<column>
<gadgets>
<gadget>/gadget/3/url.xml</gadget>
<gadget>/gadget/4/url.xml</gadget>
</gadgets>
</column>
</columns>
</tab>

Step 2 Click Save.

Finesse validates the XML file to ensure that it is valid XML syntax and conforms to the Finesse schema.
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Step 3 After you save your changes, if you want to revert to the last saved desktop layout, click Revert. If you want
to revert to the default desktop layout, click Restore Default Layout.

Note During upgrade, any changes made to the Cisco Finesse Default Layout will be not be updated.
You need to click on Restore Default Layout to get the latest changes.

XML Schema Definition

You must ensure the XML you upload conforms to the XML schema definition for Finesse. The XML schema
definition for Finesse is as follows:

<?xml version="1.0" encoding="IS0-8859-1" ?>
<xs:schema xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
targetNamespace="http://www.cisco.com/vtg/finesse"
xmlns="http://www.cisco.com/vtg/finesse"
elementFormDefault="qualified">

<!-- definition of role type -->
<xs:simpleType name="role">
<xs:restriction base="xs:string">
<xs:enumeration value="Agent"/>
<xs:enumeration value="Supervisor"/>
<xs:enumeration value="Admin"/>
</xs:restriction>
</xs:simpleType>

<!-- definition of simple elements -->
<xs:element name="id">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:pattern value="[a-zA-Z] ([-_:\.a-zA-20-9])*"/>
</xs:restriction>
</xs:simpleType>
</xs:element>

<xs:element name="label">
<xs:simpleType>
<xs:restriction base="xs:string">
<xs:minLength value="1" />
</xs:restriction>
</xs:simpleType>
</xs:element>

<xs:element name="gadget">
<xs:simpleType>
<xs:restriction base="xs:anyURI">
<xs:minLength value="1" />
</xs:restriction>
</xs:simpleType>
</xs:element>
<xs:element name="role" type="role"/>

<xs:element name="gadgets"> <!-- Grouping of a set of gadgets -->
<xs:complexType>
<xs:sequence maxOccurs="unbounded">
<!-- No limit to number of gadget URIs for now -->
<xs:element ref="gadget"/> <!-- URI of the gadget xml -->
</xs:sequence>
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</xs:complexType>
</xs:element>

<xs:element name="page"> <!-- Grouping of a set of persistent gadgets -->
<xs:complexType>
<xs:sequence maxOccurs="unbounded">
<!-- No limit to number of gadget URIs for now -->
<xs:element ref="gadget"/> <!-- URI of the gadget xml -->
</xs:sequence>
</xs:complexType>
</xs:element>

<xs:element name="tab">
<xs:complexType>
<xs:sequence>
<xs:element ref="id"/> <!-- Id of the tab selector in the desktop -->
<xs:element ref="label"/> <!-- Label of the tab selector -->
<xs:element ref="gadgets" minOccurs="0" maxOccurs="1"/>
</xs:sequence>
</xs:complexType>
</xs:element>

<xs:element name="tabs"> <!-- Grouping of tabs -->
<xs:complexType>
<xs:sequence maxOccurs="unbounded">
<!-- No limit to number of tabs for now -->
<xs:element ref="tab"/>
</xs:sequence>
</xs:complexType>
</xs:element>

<xs:element name="layout">
<xs:complexType>
<xs:sequence>

<xs:element ref="role"/> <!-- Type of the role -->
<xs:element ref="page"/> <!-- List of page gadgets -->
<xs:element ref="tabs"/> <!-- Grouping of tabs for this particular role -->

</xs:sequence>
</xs:complexType>
</xs:element>

<xs:element name="finesselLayout"> <!-- Layout of the desktop -->
<xs:complexType>
<xs:sequence maxOccurs="3">
<!-- only support 3 roles for now -->
<xs:element ref="layout" />
</xs:sequence>
</xs:complexType>
</xs:element>

</xs:schema>

Add Web Chat and Email to Finesse

The Cisco Finesse default layout XML contains commented XML code for Web Chat and Email gadgets
available for the Finesse desktop. Each gadget or tab is surrounded by comment characters (<! -- and -->)
and comments that describe what the tab or gadget is for and how to add it to the desktop.
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Note The Chat and Email Control gadget is only supported at the page level. You must ensure that the Chat
and Email Control gadget
(<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>) is placed within the
<page></page> tag. Placing this gadget within a <tab></tab> tag is not supported.

The procedure that you follow depends on your deployment. The following table describes when to use each
procedure.

Procedure When to use

Add Web Chat and Email to the default desktop Follow this procedure if you want to add Web Chat
layout. and Email to the Finesse desktop after a fresh
installation or after an upgrade if you have not
customized the default desktop layout.

Add Web Chat and Email to a custom desktop layout. | Follow this procedure if you want to add Web Chat
and Email and have customized the desktop layout.

Add Web Chat and Email to a team layout. Follow this procedure if you want to add Web Chat
and Email to the desktop only for specific teams.

\}

Note  After you add the Web Chat and Email gadgets, sign in to the Finesse desktop and make sure they appear
the way you want. Agents who are signed in to Finesse when you change the desktop layout must sign
out and sign back in to see the change on their desktops.

Add Web Chat and Email to the Default Desktop Layout

\)

Note Ifyou upgraded from a previous release but do not have a custom desktop layout, click Restor e Default
L ayout on the Manage Desktop Layout gadget and then follow the steps in this procedure.

Procedure
Step 1 In the Finesse administration console, click the Desktop L ayout tab.
Step 2 To add the Chat and Email Control gadget to the agent desktop, look for the following under the

<role>Agent</role> tag and within the <page></page> tag:

<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

Step 3 Remove the comments and comment characters (<! -- and -->) that surround the gadget, leaving only the
gadget (<gadget>https ://localhost/agentdesktop/gadgets/NonVoiceControl. xml</gadget>).
Step 4 To add the Manage Chat and Email tab and gadget to the agent desktop, look for the following within the

<tabs></tabs> tag:

<tab>
<id>manageNonVoiceMedia</id>
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Step 5
Step 6

Step 7

Step 8

Step 9

Step 10

Step 11
Step 12

Step 13

Add Web Chat and Email to the Default Desktop Layout .

<label>finesse.container.tabs.agent.manageNonVoiceMedialabel</label>

<columns>
<column>
<gadgets>
<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>
</gadgets>
</column>
</columns>
</tab>

Remove the comments and comment characters (<! -- and -->) that surround the tab.

Replace my-socialminer-server in the gadget URL with the fully-qualified domain name (FQDN) of your
SocialMiner server.

Optionally, change the height of the Manage Chat and Email gadget.

Example:

The height specified in the gadget URL is 430 pixels. If you want to change the height, change the gadgetHeight
parameter in the URL to the desired value. For example if you want the gadget height to be 600 pixels, change
the code as follows:

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=600</gadget>

The default and minimum height of the Manage Chat and Email gadget is 430 pixels. If you do not specify a

value for the gadgetHeight parameter or if you specify a value that is less than 430, the gadget defaults to 430
pixels.

Note An agent can be configured to handle up to five chat contacts and five email contacts at a time. If
the agent has the maximum number of contacts on the desktop, not all contacts are visible. If your
agents are configured to handle the maximum number of contacts, you must increase the height of
this gadget to a minimum of 570 pixels to ensure there is enough space for all of the contacts to
appear.

To add the Chat and Email Control gadget to the supervisor desktop, look for the following under the
<role>Supervisor</role> tag and within the <page></page> tag:

<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

Remove the comments and comment characters (<! -- and -->), leaving only the gadget
(<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>)

To add the Live Data report for Agent Chat Statistics to the supervisor desktop, look for the following:

<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=F2F1FC17100001440000014E0A4E5D48¢&
filterId=ChatAgentStats.agentId=CL</gadget>

Remove the comments and comment characters (<! -- and -->), leaving only the gadget.
To add the Live Data report for Chat Queue Statistics to the supervisor desktop, look for the following:

<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=E42ED788100001440000007BOA4E5CALS
filterId=ChatQueueStatistics.queueName=CL</gadget>

Remove the comments and comment characters (<! -- and -->), leaving only the gadget.
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Step 14

Step 15
Step 16

Step 17
Step 18

To add the Manage Chat and Email tab and gadget to the supervisor desktop, look for the following within
the <tabs></tabs> tag:

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMedialabel</label>

<columns>
<column>
<gadgets>
<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>
</gadgets>
</column>
</columns>
</tab>

Remove the comments and comment characters (<! -- and -->) that surround the tab.

Replace my-socialminer-server in the gadget URL with the fully-qualified domain name (FQDN) of your
SocialMiner server.

Optionally, change the height of the Manage Chat and Email gadget.
Click Save.

Add Web Chat and Email to a Custom Desktop Layout

Step 1
Step 2
Step 3

Step 4

Step 5

Step 6

Procedure

In the Finesse administration console, click the Desktop L ayout tab.
Click Finesse Default Layout XML to show the default layout XML.
Copy the XML code for the Chat and Email Control gadget for the agent desktop.

<gadget>https://localhost/agentdesktop/gadgets/NonvVoiceControl.xml</gadget>

To add the gadget to the agent desktop, paste the code within the <page></page> tags under the Call Control
gadget as follows:

<role>Agent</role>
<page>
<gadget>/desktop/gadgets/CallControl.jsp</gadget>
<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>
</page>

To add the gadget to the supervisor desktop, paste the code within the <page></page> tags under the Call
Control gadget as follows:

<role>Supervisor</role>
<page>
<gadget>/desktop/gadgets/CallControl.jsp</gadget>
<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>
</page>

Copy the code for the agent Manage Chat and Email tab and gadget from the default layout XML.

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.agent.manageNonVoiceMedialLabel</label>
<columns>
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Step 7

Step 8
Step 9

Step 10

Add Web Chat and Email to a Custom Desktop Layout .

<column>

<gadgets>
<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>

</gadgets>

</column>

</columns>
</tab>

Paste the code within the <tabs></tabs> tag for the agent role after the Manage Call tab:

<tab>
<id>manageCall</id>
<label>finesse.container.tabs.agent.manageCallLabel</label>

</tab>

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.agent.manageNonVoiceMedialabel</label>

<columns>
<column>
<gadgets>
<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>
</gadgets>
</column>
</columns>
</tab>

Replace my-social-miner-server with the FQDN of your SocialMiner server.

Optionally, change the height of the Manage Chat and Email gadget.

Example:

The height specified in the gadget URL is 430 pixels. If you want to change the height, change the gadgetHeight
parameter in the URL to the desired value. For example if you want the gadget height to be 600 pixels, change
the code as follows:

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=600</gadget>

The default and minimum height of the Manage Chat and Email gadget is 430 pixels. If you do not specify a
value for the gadgetHeight parameter or if you specify a value that is less than 430, the gadget defaults to 430
pixels.

Note An agent can be configured to handle up to five chat contacts and five email contacts at a time. If
the agent has the maximum number of contacts on the desktop, not all contacts are visible. If your
agents are configured to handle the maximum number of contacts, you must increase the height of
this gadget to a minimum of 570 pixels to ensure there is enough space for all of the contacts to
appear.

Copy the code for the Live Data gadgets for Agent Chat Statistics and Chat Queue Statistics from the default
layout XML.

<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=F2F1FC17100001440000014E0A4E5D48&
filterId=ChatAgentStats.agentId=CL</gadget>

<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=E42ED788100001440000007BO0A4ESCALL
filterId=ChatQueueStatistics.queueName=CL</gadget>
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Step 11

Step 12

Step 13

Step 14
Step 15
Step 16

Paste the code for these gadgets within the <gadgets></gadgets> tags for the tabs on which you want them
to appear.

Copy the code for the supervisor Manage Chat and Email tab and gadget from the default layout XML.

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMedialabel</label>

<columns>
<column>
<gadgets>
<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>
</gadgets>
</column>
</columns>
</tab>

Paste the code within the <tabs></tabs> tag for the supervisor role after the Manage Call tab:

<tab>
<id>manageCall</id>
<label>finesse.container.tabs.supervisor.manageCalllLabel</label>

</tab>

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMedialabel</label>

<columns>
<column>
<gadgets>
<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>
</gadgets>
</column>
</columns>
</tab>

Replace my-social-miner-server with the FQDN of your SocialMiner server.
Optionally, change the height of the gadget.
Click Save.

Add Web Chat and Email to a Team Layout

Step 1
Step 2
Step 3

Step 4

Procedure

In the Finesse administration console, click the Desktop L ayout tab.
Click Finesse Default Layout XML to show the default layout XML.
Copy the XML code for the Chat and Email Control gadget for the agent desktop and paste it into a text file.

<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>

Copy the code for the agent Manage Chat and Email tab and gadget and paste it into your text file.

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.agent.manageNonVoiceMedialabel</label>
<columns>
<column>
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Step 5

Step 6

Step 7
Step 8
Step 9
Step 10
Step 11

Step 12

Step 13

Add Web Chat and Email to a Team Layout .

<gadgets>
<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>
</gadgets>
</column>
</columns>
</tab>

Copy the code for the Live Data gadgets for Agent Chat Statistics and Chat Queue Statistics and paste it into
your text file.

<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=F2F1FC17100001440000014E0A4E5D48¢&
filterId=ChatAgentStats.agentId=CL</gadget>

<gadget>https://localhost:8444/cuic/gadget/LiveData/
LiveDataGadget.jsp?gadgetHeight=310&
viewId=E42ED788100001440000007BOA4E5CALL
filterId=ChatQueueStatistics.queueName=CL</gadget>

Copy the code for the supervisor Manage Chat and Email tab and gadget and paste it into your text file.

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMedialabel</label>

<columns>
<column>
<gadgets>
<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>
</gadgets>
</column>
</columns>
</tab>

Click the Team Resour ces tab.

Select the team from the list of teams for which you want to add Web Chat and Email.
Check the Override System Default check box.

In the Resources for <team name> area, click the Desktop L ayout tab.

To add the Chat and Email Control gadget to the agent desktop, copy the code for the gadget from your text
file and paste it within the <page></page> tags under the Call Control gadget as follows:

<role>Agent</role>
<page>
<gadget>/desktop/gadgets/CallControl.jsp</gadget>
<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>
</page>

To add the gadget to the supervisor desktop, paste the code within the <page></page> tags under the Call
Control gadget as follows:
<role>Supervisor</role>
<page>
<gadget>/desktop/gadgets/CallControl.jsp</gadget>
<gadget>https://localhost/agentdesktop/gadgets/NonVoiceControl.xml</gadget>
</page>

To add the Manage Chat and Email tab and gadget to the agent desktop, copy the code from your text file and
paste it within the <tabs></tabs> tag for the agent role after the Manage Call tab:
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<tab>
<id>manageCall</id>
<label>finesse.container.tabs.agent.manageCallLabel</label>

</tab>

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.agent.manageNonVoiceMedialabel</label>

<columns>
<column>
<gadgets>
<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>
</gadgets>
</column>
</columns>
</tab>
Step 14 Replace my-social-miner-server with the FQDN of your SocialMiner server.

Step 15 Optionally, change the height of the Manage Chat and Email gadget.

Example:

The height specified in the gadget URL is 430 pixels. If you want to change the height, change the gadgetHeight
parameter in the URL to the desired value. For example if you want the gadget height to be 600 pixels, change
the code as follows:

<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=600</gadget>

The default and minimum height of the Manage Chat and Email gadget is 430 pixels. If you do not specify a
value for the gadgetHeight parameter or if you specify a value that is less than 430, the gadget defaults to 430

pixels.

Note An agent can be configured to handle up to five chat contacts and five email contacts at a time. If
the agent has the maximum number of contacts on the desktop, not all contacts are visible. If your
agents are configured to handle the maximum number of contacts, you must increase the height of
this gadget to a minimum of 570 pixels to ensure there is enough space for all of the contacts to
appear.

Step 16 To add the Live Data gadgets for Web Chat and Email to the supervisor desktop:

a) Copy the code for the Agent Chat Statistics Live Data gadget from your text file and paste it within the
<gadgets></gadgets> tags for the tab on which you want it to appear.

b) Copy the code for the Chat Queue Statistics Live Data gadget from your text file and paste it within the
<gadgets></gadgets> tags for the tab on which you want it to appear.

Step 17 To add the Manage Chat and Email tab gadget to the supervisor desktop, copy the code from your text file
and paste it within the <tabs></tabs> tag for the supervisor role after the Manage Call tab:

<tab>
<id>manageCall</id>
<label>finesse.container.tabs.supervisor.manageCalllLabel</label>

</tab>

<tab>
<id>manageNonVoiceMedia</id>
<label>finesse.container.tabs.supervisor.manageNonVoiceMedialLabel</label>

<columns>
<column>
<gadgets>
<gadget>https://my-socialminer-server/multisession/ui/gadgets/
multisession-reply-gadget.jsp?gadgetHeight=430</gadget>
</gadgets>
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</column>
</columns>
</tab>
Step 18
Step 19 Optionally, change the height of the gadget.
Step 20 Click Save.

Live Data Gadgets

Live Data Gadgets .

Replace my-social-miner-server with the FQDN of your SocialMiner server.

Cisco Finesse for Unified CCX supports Live Data gadgets. Live Data gadgets display information about the
current state of the contact center. The gadgets receive data from the real-time data source at frequent intervals
and display reports in grid format only.

Cisco Unified Intelligence Center provides Live Data real-time reports that you can add to the Cisco Finesse

agent and supervisor desktop.

This feature provides the following access:

* Agents can access the Live Data agent reports.

* Supervisors can access the Live Data supervisor reports.

Gadgets URLs for Reports
The following table displays gadgets URLs for reports.
Users Reports Report View Isthe |Tab Gadget URLs
Report
Available
in
Default
Layout ?
Agent Agent CSQ Agent CSQ Yes Home <gadget>https://localhost:8444/cuiqg
Staﬁsﬁcs]leport Staﬁsﬁcs]leport /gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=76D964AD10000140000000830A4E5E6H
&filterId=AgentCSQStats.csgName
=CL&compositeFilterId
=AgentCSQStats.AgentIds.agentId
=loginId</gadget>
Agent Agent State Log | Agent State Log | Yes My <gadget>https://localhost:8444/cuig
Report Report Statistics /gadget/LiveData/LiveDataGadget. jspy
gadgetHeight=420&viewId
=5D411E8A10000140000000230A4E5E6B
&filterId=AgentStateDetailStats.agentIl
=loginId</gadget>
Agent Agent Statistics | Agent Statistics | Yes My <gadget>https://localhost:8444/cuig
Report Report Statistics /gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=150&viewId
=67D4371110000140000001080A4E5E6B
&filterId=ResourceIAQStats.resourceld
=loginId</gadget>
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Users

Reports

Report View

Is the
Report
Available
in
Default
Layout ?

Tab

Gadget URLs

Agent

Agent Team
Summary Report

Agent Team
Summary Report

Yes

Home

<gadget>https://localhost:8444/cuid
/gadget/LiveData/LiveDataGadget. jsp?
gadgetHeight=310&viewId
=5C626F9C10000140000000600A4E5B33
&filterId=ResourceIAQStats.
resourcelId=CL</gadget>

Supervisor

Agent Outbound
Team Summary
Report

Report since
midnight

No

Team
Data

<gadget>https://localhost:8444/cuid
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=FD919FB9100001440000005D0A4E5B29
&filterId=ResourceIAQStats.
resourceld=CL</gadget>

Supervisor

Agent Outbound
Team Summary
Report

Short and long
term average

No

Team
Data

<gadget>https://localhost:8444/cuid
/gadget/LiveData/LiveDataGadget. jspy
gadgetHeight=310&viewId
=FD919FB510000144000000470A4E5B29
&filterId=ResourceIAQStats.
resourceld=CL</gadget>

Supervisor

Chat Agent
Statistics Report

Chat Agent
Statistics Report

No

Team
Data

<gadget>https://localhost:8444/cuiqg
/gadget/LiveData/LiveDataGadget.jsp?]
gadgetHeight=120&viewId
=F2F1FC17100001440000014E0A4E5D48
&filterId=ChatAgentStats.
agentId=CL</gadget>

Supervisor

Chat CSQ
Summary Report

Chat CSQ
Summary Report

No

Queue
Data

<gadget>https://localhost:8444/cuiqg
/gadget/LiveData/LiveDataGadget . jsp?
gadgetHeight=120&viewId
=E42ED788100001440000007BOA4ES5CAL
&filterId=ChatQueueStatistics.
queueName=CL</gadget>

Supervisor

Email Agent
Statistics Report

Email Agent
Statistics Report

No

Team
Data

<gadget>https://localhost:8444/cuid
/gadget/LiveData/LiveDataGadget. jsp?
gadgetHeight=310&viewId
=BCC5767B1000014F000000580A4D3FAT,
&filterId=EmailAgentStats.
agentId=CL</gadget>

Supervisor

Email CSQ
Summary Report

Email CSQ
Summary Report

No

Queue
Data

<gadget>https://localhost:8444/cuiqg
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=13970B4E100001500000021COA4D3FATY
&filterId=EmailQueueStatistics.
queueName=CL</gadget>

Supervisor

Team State
Report

Team State
Report

No

<gadget>https://localhost:8444/cuid
/gadget/LiveData/LiveDataGadget. jsp?
gadgetHeight=310&viewId
=5C90012F10000140000000830A4E5B33
&filterId=ResourceIAQStats.
resourceld=CL</gadget>
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Live Data Gadgets .

Users

Reports

Report View

Is the
Report
Available
in
Default
Layout ?

Tab

Gadget URLs

Supervisor

Team Summary
Report

Report since
midnight

Yes

Team
Data

<gadget>https://localhost:8444/cuid
/gadget/LiveData/LiveDataGadget. jsp?
gadgetHeight=310&viewId
=728283C210000140000000530A4E5B33
&filterId=ResourceIAQStats.
resourcelId=CL</gadget>

Supervisor

Team Summary
Report

Short and long
term average

Yes

Team
Data

<gadget>https://localhost:8444/cuid
/gadget/LiveData/LiveDataGadget.jsp?
gadgetHeight=310&viewId
=7291DCB410000140000000890A4E5B33
&filterId=ResourceIAQStats.
resourceld=CL</gadget>

Supervisor

Voice CSQ
Agent Detail
Report

Voice CSQ
Agent Detail
Report

Yes

Queue
Data

<gadget>https://localhost:8444/cuid
/gadget/LiveData/LiveDataGadget. jspy
gadgetHeight=310&viewId
=9A7A14CE10000140000000EDOA4ESE 6B
&filterId=VoiceCSQDetailsStats.
agentId=CL&compositeFilterId
=VoiceCSQDetailsStats.AgentVoiceCSONames .|
agentVoiceCSQName=CL</gadget>

Supervisor

Voice CSQ
Summary

Snapshot

Yes

Queue
Data

<gadget>https://localhost:8444/cuiq
/gadget/LiveData/LiveDataGadget.jsp?]
gadgetHeight=310&viewId
=C8E2DB1610000140000000A60A4E5E6H
&filterId=VoiceIAQStats.
esdName=CL</gadget>

Supervisor

Voice CSQ
Summary

Short and long
term average

Yes

Queue
Data

<gadget>https://localhost:8444/cuiqg
/gadget/LiveData/LiveDataGadget . jsp?
gadgetHeight=310&viewId
=C8EE241910000140000000C30A4E5E6B
&filterId=VoiceIAQStats.
esdName=CL</gadget>

Supervisor

Voice CSQ
Summary

Report since
midnight

Queue
Data

<gadget>https://localhost:8444/cuid
/gadget/LiveData/LiveDataGadget. jsp?
gadgetHeight=310&viewId
=C8EF510810000140000000EBOA4ESE6B
&filterId=VoiceIAQStats.
esdName=CL</gadget>

Gadgets Customization

You can use optional query parameter to adjust height of the gadgets.

Query Parameter

<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?

gadgetHeight=200&viewId=5C626F9C10000140000000600A4E5B33&filterId=ResourceIAQStats. resourceId=CL</gadget>
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Add Live Data Gadgets to Desktop Layout

The Cisco Finesse default layout XML contains commented XML code for the Live Data gadgets available
for Cisco Finesse desktop. Perform the following steps to add Live Data gadgets to desktop layout:

Procedure

Step 1 Sign in to Cisco Finesse administration console.
Cisco Finesse home page appears.

Step 2 Click the Desktop Layout tab.
Step 3 Click Finesse Default Layout XML to show the default layout XML.
Step 4 Copy the gadget URL for the report you want to add from Live Data Gadgets.

Example:
To add the Agent Report, copy the following:

<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight
=150&viewId=67D4371110000140000001080A4E5E6B&filterId=ResourceIAQStats.resourceld=1oginId</gadget>

Step 5 Paste the gadget URL within the tab tags where you want it to appear.

Example:
To add the report to the home tab of the agent desktop:

<finesselLayout xmlns="http://www.cisco.com/vtg/finesse">
<layout>
<role>Agent</role>
<page>
<gadget>/desktop/gadgets/CallControl.jsp</gadget>
</page>
<tabs>
<tab>
<id>home</id>
<label>finesse.container.tabs.agent.homeLabel</label>
<gadgets>
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight
=310&viewId=76D964AD10000140000000830A4E5E6F&filterId=AgentCSQStats.csqName
=CL&compositeFilterId=AgentCSQStats.AgentIds.agentId=loginId</gadget>
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight
=310&viewId=5C626F9C10000140000000600A4E5B33&filterId
=ResourcelIAQStats.resourceld=CL</gadget>
</gadgets>
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight
=150&viewId=67D4371110000140000001080A4ESE6B&filterId=ResourcelAQStats.resourceld
=loginId</gadget>
</tab>
<tab>
<id>myStatistics</id>
<label>finesse.container.tabs.agent.myStatisticsLabel</label>
<gadgets>
<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight
=600&viewId=5D411E8A10000140000000230A4E5E6B&filterId=AgentStateDetailStats.agentID
=loginId</gadget>
</gadgets>
</tab>
<tab>
<id>manageCall</id>
<label>finesse.container.tabs.agent.manageCallLabel</label>
</tab>
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</tabs>
</layout>
<layout>
<role>Supervisor</role>
<page>
<gadget>/desktop/gadgets/CallControl.jsp</gadget>
</page>

Step 6 Click Save. Cisco Finesse validates the XML file to ensure that it is valid XML syntax and conforms to the
Cisco Finesse schema.

Step 7 To verify, log in to Cisco Finesse agent desktop as agent/Cisco Finesse supervisor desktop as supervisor and
check the reports.

Related Topics
Live Data Gadgets, on page 27

Add Customized Live Data Gadgets to Desktop Layout

This procedure explains how to create gadget URLSs for customized Live Data reports, which are copied from
stock reports, and add them to desktop layout.

)

Note The new gadget renders the report only when the appropriate permission on that report is given in Cisco
Unified Intelligence Center.

Procedure

Step 1 Copy the gadget URL of the stock report that you want to customize from L ive Data Gadgets and paste it in
a text editor.
Example:

Consider the URL shown here as the gadget URL. Copy and paste it in a text editor. The underlined ID is the
value of viewID.

<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310
&viewId=5C626F9C10000140000000600A4E5B33&filterId=ResourcelAQStats.resourceld=CL</gadget>

Step 2 In Cisco Unified Intelligence Center, in the Edit view of the customized report, select the view for which you
want to create the gadget URL and then click Links.

The HTML Link field displays the permalink of the customized report.

Step 3 Copy the permalink of the customized report from the HTML Link field and paste it in a text editor, then
copy the viewID value from this link.

Example:
Copy the underlined viewID value from the permalink of the customized report.

https://<Server Name>:8444/cuic/permalink/PermalinkViewer.htmx?
viewId=5C90012F10000140000000830A4E5B33&linkType=htmlType&viewType=Grid

Step 4 Replace the viewlID value in the gadget URL with the viewID value from the permalink of the customized
report.

Cisco Finesse .
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Step 5
Step 6

Cisco Finesse |

Example:

The customized gadget URL appears as shown here after replacing the viewID value with the viewID value
of the customized report.

<gadget>https://localhost:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310
&viewId=5C90012F10000140000000830A4E5B33&filterId=ResourcelAQStats.resourceld=CL</gadget>

Add the customized gadget URL to Desktop Layout in the Finesse administration console and save.

Log in to Finesse desktop and check the report.

Related Topics
Live Data Gadgets, on page 27

Live Data Reports

Cisco Unified Intelligence Center provides Live Data real-time reports that you can add to the Finesse desktop.

Configure Live Data Reports with Multiple Views

Step 1

Cisco Finesse allows you to display multiple Live Data reports or views on a single gadget. Supervisors can
select the desired view to display from a drop-down list on the gadget toolbar, which lists up to five report
views in Report Name - View Name format.

This procedure describes how to add multiple Live Data views to the Finesse desktop layout using the viewld n
and filterld_n keys. You can specify up to five report views to appear in your gadget. The first view among
the five is the default view. There is no defined order for how the remaining views are displayed.

Finesse still supports the display of a single gadget using a single viewld. However, if you specify the single
viewld along with multiple viewld n keys, the multiple views are used and the single viewld is ignored.

\}

Note To make sure the modified gadget renders in the Finesse desktop, you must give the appropriate
permission for that report in Unified Intelligence Center.

Procedure

For each report or view that you want to include in the gadget, obtain the associated viewld from the permalink
for the view:

a) In Unified Intelligence Center, in Edit view of the report, select the desired view then click Links.

The HTML Link field displays the permalink of the customized report.

b) Copy the permalink of the customized report from the HTML Link field, and paste it in a text editor, and
then copy the viewlD value from the permalink and save it.

Example:

Copy the viewld, which is underlined in this example, from the permalink for the report.

https://<Server Name>:8444/cuic/permalink/PermalinkViewer.htmx?
viewId=5C90012F10000140000000830A4E5B3381inkType=htmlTypesviewType=Grid
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Step 2

Step 3

Step 4

Configure Live Data Reports with Multiple Views .

From the Finesse default layout XML, copy the gadget URL for one of the Live Data reports and paste it into
a text editor.

Example:

Copy the URL for the Agent Skill Group for HTTPS from the default layout XML and paste it into a text
editor:

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId 1=9AB7848B10000141000001C50A0006C4&filterId l=agent.id=CL%20teamName</gadget>

To update the URL to refer to a different report view, populate the viewld_1 value (after the equal sign) with
the desired viewld obtained in step 1.

Example:
The following shows the URL updated with the example viewld copied from step 1.

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId 1=5C90012F10000140000000830A4E5B33&filterId l=agent.id=CL%20teamName</gadget>

For each additional view you want to include:
a) At the end of the URL, copy and paste the viewld 1 and agentld 1 strings with a leading ampersand.

Example:

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId 1=5C90012F10000140000000830A4E5B33&filterId l=agent.id=CL%20teamNames&
viewId 1=5C90012F10000140000000830A4E5B33&filterId l=agent.id=CL%20teamName</gadget>

b) Update the copied viewld 1 and filterId 1 in the URL to the next available integer (in this example,
viewld 2 and filterld 2).

Example:

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget . jsp?gadgetHeight=310&
viewId 1=5C90012F10000140000000830A4E5B33&filterId l=agent.id=CL%20teamNames&
viewId 2=5C90012F10000140000000830A4E5B33&filterId 2=agent.id=CL%20teamName</gadget>

¢) Populate the copied viewld value (after the equal sign) with the value defined in the permalink for the
desired report (in this example, 99E6C8E210000141000000D80A0006C4).

Example:

<gadget>https://my-cuic-server:8444/cuic/gadget/LiveData/LiveDataGadget.jsp?gadgetHeight=310&
viewId 1=5C90012F10000140000000830A4E5B33&filterId l=agent.id=CL%20teamNames&
viewId 2=99E6C8E210000141000000D80A0006C4sfilterId 2=agent.id=CL%20teamName</gadget>

d) Make sure that the filterld value matches the type required by the report type, as follows:

» Agent Reports: filterld N=agent.id=CL%20teamName
 Agent Skill Group Reports: filterld N=agent.id=CL%20teamName
« Skill Group Reports: filterld N=skillGroup.id=CL%20teamName

* Precision Queue Reports: filterld N=precisionQueue.id=CL%20teamName

Cisco Finesse .



. Manage Phone Books

Cisco Finesse |

Step 5 Replace my-cuic-server with the fully qualified domain name of your Cisco Unified Intelligence Center Server.
Step 6 Add the customized gadget URL to the desktop layout XML in the Manage Desktop Layout gadget and click
Save.
Note After you add the gadget, sign in to the Finesse desktop and make sure it appears the way you want.

If you use a report with a large number of rows, you may want to adjust the gadget height or the
screen resolution on the computer used to access the desktop to make the report easier to read or
make more rows appear on the screen without the need to scroll.

Agents who are signed in when you change the desktop layout must sign out and sign back in to
see the change on their desktops.

Manage Phone Books

On the Phone Books tab of the Cisco Finesse administration console, you can create and manage global and
team phone books and phone book contacts. Global phone books are available to all agents; team phone books
are available to agents in that specific team.

Phone Books and Contacts

Finesse supports the following number of phone books:

* 10 global phone books

* 300 team phone books

The system supports a total of 50,000 contacts. The total number of contacts per agent across all phone books

1s limited to 1500.

Use the Manage Phone Books gadget to view, add, edit, or delete phone books and phone book contacts. Click
the Name or Assign To headers to sort the phone books in ascending or descending order. Click the last Name,
First Name, Number, or Note headers to sort the contacts in ascending or descending order.

The following table describes the fields on the Manage Phone Books gadget.

Field

Explanation

Name

The name of the phone book. The name must be unique, and can be a maximum
length of 64 alphanumeric characters.

Assign To

Indicates if the phone book is global (All Users) or team (Teams).

Last Name

The last name of a contact. The last name can be a maximum length of 128
characters. This field is optional.

First Name

The first name of a contact. The first name can be a maximum length of 128
characters. This field is optional.

Number

The phone number for the contact. The phone number can be 1-32 characters long
and cannot be blank.
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Add Phone Book

Step 1

Step 2

Step 3

Step 4

Edit Phone Book

Step 1
Step 2

Step 3

Step 4

Add Phone Book [J|j

Field Explanation

Note Optional text that describes the contact. The note can be a maximum length of
128 characters.

Actions on the M anage Phone Books gadget:

* New: Add a new phone book or contact

« Edit: Edit an existing phone book or contact

* Delete: Delete a phone book or contact

* Refresh: Reload the list of phone books or contacts from the server
» Import: Import a list of contacts to the phone book

» Export: Export a list of contacts from the phone book

Procedure

In the Manage Phone Books gadget, click New.

The Manage Phone Books area appears.

In the Name box, enter a name for the phone book.
Note Phone book names can be a maximum length of 64 characters.

In the Assign To box drop-down list, select All User sif the phone book is global or Teamsif the phone book
is available to specified teams.

Click Save.

Procedure

In the Manage Phone Books gadget, select the phone book you want to edit.
Click Edit.

The Edit Phone Books area appears.

In the Name field, enter the new name for the phone book. If you want to change who can access the phone
book, in the Assign To field drop-down list, choose All Users or Teams.

Click Save.
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If you change the Assign To field from Teams to All Users, a message appears that asks you to confirm the
change. Click Yes to confirm.

Delete Phone Book

Step 1
Step 2

Step 3

Import Contacts

Procedure

In the Manage Phone Books gadget, select the phone book that you want to delete.
Click Delete.

A question appears asking you to confirm that you want to delete the selected phone book.

Click Yesto confirm the deletion of the selected phone book.

The Import function allows you to replace all the contacts in a phone book with a new list of contacts, or to
populate a new phone book with contacts.

The import list must be in the specified comma separated values (CSV) format, and can contain a maximum
of 1500 contacts. Import lists that contain more than 1500 contacts are rejected with an error message.

The CSYV file contains the fields described in the following table.

Field Max Can Be Permitted Characters
Length |Blank?

First Name | 128 Yes Alphanumeric characters

Last Name | 128 Yes Note The: CSV ﬁlle that contains the contacts to import must use
Latin encoding.

Phone 32 No

Number

Notes 128 Yes

The following is an example of a phone book CSV file:

"First Name","Last Name", "Phone Number", "Notes"
"Amanda", "Cohen","6511234",""
"Nicholas","Knight","612-555-1228","Sales"
"Natalie", "Lambert","952-555-9876", "Benefits"
"Joseph", "Stonetree","651-555-7612", "Manager"

A phone book CSV file must conform to this format and include the headers in the first line. During import,
the file is scanned for illegal characters. If any are found, they are replaced with question marks.
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Export Contacts .

\)

Note Exported CSV files always show each field enclosed in double quotes, as in the preceding example, to

Step 1
Step 2

Step 3

Step 4

Export Contacts

Step 1
Step 2

Step 3

Step 4

ensure that any commas or double quotes that are part of the actual filed data are not mistaken for field
delimiters. If your data does not include these characters, you can omit the double quotes in files you
prepare for importing.

Procedure

In the Manage Phone Books gadget, select the phone book into which you want to import a list of contacts.
Click Import.

The Import Contacts area appears.

Click Browse and navigate to the location of the CSV file containing the contacts you want to import.

Note The CSV file must use Latin encoding.

Click OK.

The Export function allows you to extract a list of contacts from an existing phone book. The exported list is
saved in CSV format.

Procedure

In the Manage Phone Books gadget, select the phone book that contains the contacts you want to export.
Click Export.

A message is displayed asking if you want to open or save the file.

Note The default name for an export file is PhoneBookContacts.csv.

Click Open to open the CSV file in Excel, or click the Save drop-down list and choose Save, Save as, or
Save and open, as desired.

A message appears that gives you the option to view the downloaded file, open the folder into which the
download was saved, view the Internet Explorer View Downloads window, or dismiss the message without
viewing the file.
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Add Contact

Step 1

Step 2

Step 3

Step 4

Edit Contact

Step 1

Step 2
Step 3

Step 4

Step 5

Delete Contact

Step 1

Step 2
Step 3

Cisco Finesse |

Procedure

In the Manage Phone Books gadget, select the phone book to which you want to add a contact.

The List of Contacts for <phone book name> area appears.
Click New.

The New Contact area appears.

Complete the fields. The First Name, Last Name, and Note fields are optional and have a maximum length
of 128 characters. The Number field is required and has a maximum length of 32 characters.

Click Save.

Procedure

In the Manage Phone Books gadget, select the phone book that contains the contact you want to edit.

The List of Contacts for <phone book name> area appears.

Select the contact you want to edit.
Click Edit.

The Edit Contact area appears.

Edit the fields that you want to change. The First Name, Last Name, and Note fields are optional and have a
maximum length of 128 characters. The Number field is required and has a maximum length of 32 characters.

Click Save.

Procedure

In the Manage Phone Books gadget, select the phone book that contains the contact you want to delete.

The List of Contacts for <phone book name> area appears.

Select the contact that you want to delete.
Click Delete.

A question appears asking you to confirm that you want to delete the selected contact.
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Step 4 Click Yes to confirm the deletion of the selected contact.

Manage Reasons

The Reasons tab on the Cisco Finesse administration console allows you to view, add, edit, and delete Not
Ready reason codes, Sign Out reason codes, and Wrap-Up reasons.

)

Note Certain reason codes are reserved and cannot be used.

For Unified CCX systems, these reserved reason codes are as follows: 0, 22, and 33.

Not Ready Reason Codes
Not Ready reason codes represent reasons that agents can select when they change their state to Not Ready.

Use the Manage Reason Codes (Not Ready) gadget to view, add, edit, or delete Not Ready reason codes.
Click the Reason Label or Reason Code headers to sort the Not Ready reason codes by label or reason code
in ascending or descending order. Click the Type header to sort and display system or custom reason codes.
Click the Global header to sort reason codes by whether they are global (Yes) or not (No).

Not Ready reason codes can be global (visible to all agents) or team (visible only to agents on specified teams).

)

Note Finesse supports a total of 200 Not Ready reason codes. This includes a maximum of 100 global Not
Ready reason codes, and 100 Not Ready team reason codes. The team reason codes can be mapped to
any team, and the same reason code can be mapped to multiple teams.

The following table describes the fields on the Manage Reason Codes (Not Ready) gadget.

Field Explanation

Reason Label The label for the Not Ready reason code.

The label has a maximum length of 40 characters and should be unique for each
Not Ready reason code. Both alphanumeric and special characters are supported.

Type The type of reason code (System or Custom).

The column is default and can be sorted to display both System reason codes and
Custom reason codes.

Reason Code A code for the Not Ready reason.

The value of the code must be between 1 and 999 and must be unique.

Global? Yes/No. Indicates if the reason code is available globally to all agents (Yes) or to
specific teams of agents (No).

Actions on the M anage Reason Codes (Not Ready) gadget:
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. Add Not Ready Reason Code

* New: Add a new Not Ready reason code
« Edit: Edit an existing Not Ready reason code
* Delete: Delete a Not Ready reason code

* Refresh: Reload the list of Not Ready reason codes from the server

\}

Note When you add, edit, or delete a Not Ready reason code, the changes you make take effect on the Finesse
desktop after three seconds. However, agents who are signed in when the changes are made must sign
out and sign back in to see those changes reflected on their desktops.

When an agent signs in to the Finesse desktop, the agent state is set to Not Ready. The agent can then choose
to go to Ready status or choose from one of the configured Not Ready reason codes from the agent state
drop-down list.

If an agent wants to change from Ready to Not Ready status, that agent can choose the appropriate Not Ready
reason code from the list of configured codes.

An agent who is on a call can select a state to be applied when the call is complete. For example, if an agent
wants to be in Not Ready state when the call ends, that agent can choose Not Ready from the drop-down list
while still on the call. The Finesse desktop shows the agent in Talking state and a pending state of Not Ready.

Pending state changes appear on the desktop while the agent's state is Talking (for example, on hold, in a
consult call, conference, or silent monitor call).

\)

Note During a PG or CTI server failover, the pending state of an agent will not be retained.

Add Not Ready Reason Code

Step 1

Step 2

Step 3

Perform the following procedure to add a new Not Ready reason code.

Procedure

In the Manage Reason Codes (Not Ready) gadget, click New.

The New Reason Code area appears.

In the Reason Label box, enter a label for the reason code.

Note Not Ready reason code labels are limited to 40 characters.

In the Reason Code box, an auto populated reason code is displayed. If you choose not to save the pre populated
reason code, you can enter your own reason code.

Note The code must be between 1 and 999 and must be unique.

Ensure there are no leading or trailing spaces.
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Step 4

Step 5

Edit Not Ready Reason Code .

If the reason code is global, select the Global? check box. If the reason code is specific to a team, clear the
Global? check box.

Note By default, the Global? check box is selected.

Click Save.

Note The Finesse server removes leading or trailing spaces before saving the Reason Label in the database.

Edit Not Ready Reason Code

Step 1
Step 2

Step 3

Step 4

Perform the following procedure to edit the label or code for an existing Not Ready reason code.

Procedure

In the Manage Reason Codes (Not Ready) gadget, select the reason code that you want to edit.
Click Edit.

The Edit Reason Code area appears.

If you want to change the label for the Not Ready reason code, in the Reason Label field, enter a new label
for the reason code. If you want to change the code, in the Reason Code field, enter the new code. If you want
to change who has access to the code, select or clear the Global? check box.

Click Save.

Delete Not Ready Reason Code

Step 1
Step 2

Step 3

\ )

Note An error may occur if an agent selects a Not Ready reason code after it has been deleted. Agents who

are signed in when you make changes to Not Ready reason codes must sign out and sign back in to see
those changes reflected on their desktops.

Perform the following procedure to delete a Not Ready reason code.

Procedure

In the Manage Reason Codes (Not Ready) gadget, select the Not Ready reason code that you want to delete.
Click Delete.

A question appears asking you to confirm that you want to delete the selected reason code.

Click Yesto confirm the deletion of the selected reason code.
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Sign Out Reason Codes

Sign Out reason codes represent reasons that agents can select when they sign out of the Finesse desktop.

Use the Manage Reason Codes (Sign Out) gadget to view, add, edit, or delete Sign Out reason codes. Click
the Reason Label or Reason Code headers to sort the Sign Out reason codes by label or by reason code, in
ascending or descending order. Click the Type header to sort and display system or custom reason codes.
Click the Global header to sort the reason codes by whether they are global (Yes) or not (No).

Sign Out reason codes can be global (visible to all agents) or team (visible only to agents on specified teams).

)

Note Finesse supports a total of 200 Sign Out reason codes. This includes a maximum of 100 global Sign Out
reason codes, and 100 Sign Out team reason codes. The team reason codes can be mapped to any team,
and the same reason code can be mapped to multiple teams.

The following table describes the fields on the Manage Reason Codes (Sign Out) gadget.

Field Explanation

Reason Label The label for the Sign Out reason code.

The label has a maximum length of 40 characters and should be unique for each
Sign Out reason code. Both alphanumeric and special characters are supported.

Type The type of reason code (System or Custom).

The column is default and can be sorted to display both System reason codes and
Custom reason codes.

Reason Code A code for the Sign Out reason.

The code must be between 1 and 999 and must be unique.

Global? Yes/No. Indicates if the reason code is available globally to all agents (Yes) or to
specific teams of agents (No).

Actions on the M anage Reason Codes (Sign Out) gadget:

* New: Add a new Sign Out reason code
» Edit: Edit an existing Sign Out reason code
* Delete: Delete a Sign Out reason code

* Refresh: Reload the list of Sign Out reason codes from the server

\}

Note When you add, edit, or delete a Sign Out reason code, the changes you make take effect on the Finesse
desktop after three seconds. However, agents who are signed in when the changes are made must sign
out and sign back in to see those changes reflected on their desktops.

When an agent clicks Sign Out on the desktop, any configured Sign Out codes appear in a drop-down list.
The agent can then choose the code that represents why that agent is signing out.

. Cisco Finesse




| Cisco Finesse

Add Sign Out Reason Code .

Add Sign Out Reason Code

Step 1

Step 2

Step 3

Step 4

Step 5

Perform the following procedure to add a new Sign Out reason code.

Procedure

In the Manage Reason Codes (Sign Out) gadget, click New.

The New Reason Code area appears.

In the Reason Label box, enter a label for the reason code.

Note Sign Out reason code labels are limited to 40 characters.

In the Reason Code box, an auto populated reason code is displayed. If you choose not to save the pre populated
reason, you can enter your own reason code.

Note The code must be between 1 and 999 and must be unique.

Ensure there are no leading or trailing spaces.

If the reason code is global, select the Global? check box. If the reason code is specific to a team, clear the
Global? check box.

Note By default, the Global? check box is selected.

Click Save.

Edit Sign Out Reason Code

Step 1
Step 2

Step 3

Step 4

Perform the following procedure to edit the label or code for an existing Sign Out reason code.

Procedure

In the Manage Reason Codes (Sign Out) gadget, select the reason code that you want to edit.
Click Edit.

The Edit Reason Code area appears.

If you want to change the label of the Sign Out reason code, in the Reason Label field, enter a new label for
the reason code. If you want to change the code, in the Reason Code field, enter the new code. If you want to
change who has access to the code, select or clear the Global? check box.

Click Save.
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Delete Sign Out Reason Code

\)

Note An error may occur if an agent selects a Sign Out reason code after it has been deleted. Agents who are
signed in when you make changes to Sign Out reason codes must sign out and sign back in to see those
changes reflected on their desktops.

Perform the following procedure to delete a Sign Out reason code.

Procedure

Step 1 In the Manage Reason Codes (Sign Out) gadget, select the Sign Out reason code that you want to delete.

Step 2 Click Delete.

A question appears asking you to confirm that you want to delete the selected reason code.

' Manage Reason Codes (Sign Out)
E__

End of Shift
Connection Failure
Supervisor Initiated
Force Logout
System Disconnect
System Failure
Device Error
Inactivity Timeout
Queue Change

A\ Are you sure you want to delete the selected Reason Code? (End of Shift)

o s

Step 3 Click Yesto confirm the deletion of the selected Sign Out reason code.

Predefined System Reason Codes

Custom
System
System
System
System
System
System
System
System

5804
2535
999
20002
50001
50002
50003
50004
50020

Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

510223

For Not Ready system reason codes and Sign Out system reason codes, only the reason code label can be
edited and saved. The Global attribute and system code cannot be modified. In case the system reason code
label is modified and you wish to revert to the default label, refer to the following list of predefined system

reason codes:

System
Reason
Code

Reason L abel

Reason L abel Description

32767

Logged Out - Device
Conflict

The system issues this reason code when an agent is already logged
in to one device (computer or phone) and then tries to re-login to
a second device.
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32765 Logged Out - System The system issues this reason code when a Cisco Finesse IP Phone
Disconnect Agent or Cisco Finesse desktop crashes due to any reason or if
the connection is disrupted.

32764 Logged Out - System The system issues this reason code when the active server becomes

Standby the standby server and the agent loses connection to the Unified

CCX Platform.

32763 Not Ready - Call Not The system issues this reason code when the agent fails to answer

Answered a Unified CCX call within the specified timeout period.

32762 Not Ready - Offhook The system issues this reason code when the agent goes off the
hook to place a call. If the agent remembers to do this task the
corresponding agent-triggered reason code is displayed. If the
agent does not remember to do this task, the system issues this
reason code.

32761 Not Ready - Non ACD The system issues this reason code when the agent is logged on

Busy to the Cisco Finesse desktop or Cisco Finesse IP phone and then
receives a call that is not queued on the Unified CCX Platform.

32760 Not Ready - Log On The system issues this reason code when an agent logs in and is
automatically placed in the Not Ready state.

32759 Not Ready - Phone Failure | The system issues this reason code if the agent’s phone crashes
and that agent is placed in the unavailable state.

32758 Not Ready - Wrap Up The system issues this reason code when an agent’s state is

Timer Expiry changed from WORK to Not Ready. This change occurs if the

WORK state for that agent’s CSQ is associated with an expired

wrap-up timer.

32757 Not Ready - CUCM The system issues this reason code when the Unified CM fails

Failover over and the agent is moved to the Not Ready state.
32756 Not Ready - Phone The system issues this reason code when the agent’s phone comes
Working up after it has been through a Phone Down state.

32755 Not Ready - Call Ended | The system issues this reason code when an agent is moved to the
Not Ready state after handling a Unified CCX call. This situation
occurs in one of two cases:

1. Ifanagent (Agent 1) is in the Not Ready state and gets a
consult Unified CCX call from another agent (Agent 2). In
this case, after handling the call, Agent 1 moves back to the
Not Ready state.

2. Ifan agent’s Automatic Available option is disabled and this
agent gets a Unified CCX call, then this agent goes to the Not
Ready state after handling the call.

32749 Not Ready - Call Cancel | The system issues this reason code when an agent’s state is

changed from TALKING to Not Ready because of the Cancel
feature. The feature is triggered during an ICD consult call between
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two agents. When the consulting agent presses the Cancel softkey
on the phone, the consulted agent is no longer associated with an
ICD call and their state changes to Not Ready. This feature is only
available on some newer phone models.

32754 Not Ready - Restricted The system issues this reason code if the agent device is flagged

Device as a restricted device by the Unified CM Administrator.
32753 Not Ready - Restricted The system issues this reason code if the agent’s phone line is
Line flagged as a restricted device by the Unified CM Administrator.
32752 Not Ready - Cancel The system issues this reason code when an agent receives a
Reservation Preview Call |preview outbound call and decides to cancel the reservation by
pressing "Decline" button on Cisco Finesse desktop.
32751 Not Ready - Skip Preview | The system issues this reason code when an agent receives a
Call preview outbound call and skips the call.

32748 Log Out - Agent Deleted | Agent is logged out from Unified CCX as the agent is deleted
from Unified Communications Manager. This event is triggered
when Unified CCX synchronizes the agent information with
Unified Communications Manager.

32750 Not Ready - Extension The system issues this reason code when an agent is logged out

Modified from CCX because the agent’s IPCC extension was changed in
Unified Communications Manager.
32742 Not Ready - Non ACD Agent's state is changed from Ready state to Not Ready state when
Offhook the monitored Non ICD lines are used for Incoming or Outgoing
calls.

32741 Logged Out - Extension | The system issues this reason code when an agent logs in to Cisco

Conflict Finesse using an extension number that has already been used by
another agent to log in, the first agent is logged out forcibly with
this reason code.
32740 Logout - System Initiated | The system logs out the agent from one session when the agent
Relogin tries to log in with the same credentials in another session.

33 Not Ready - Supervisor | The system issues this reason code when the Supervisor changes
Initiated an agent’s state to Not Ready state.

22 Logged Out - Supervisor | The system issues this reason code when the Supervisor changes
Initiated an agent’s state to log out.

255 Logged Out - Connection | The system issues this reason code when the agent is forcibly
Failure logged out when there is a connection failure between the Cisco

Finesse Desktop and the Cisco Finesse Server.

Manage Reason Code Conflicts During Upgrade

System Reason Codes are auto generated reason codes that may conflict with custom reason codes when
upgrading from an older version to Cisco Finesse 11.6(1) or higher versions. If there is a reason code conflict
then the following message appears when you sign in to the administration console:
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Custom reason codes conflict with system reason codes. Resolve to avoid reporting inconsistency.

\)

Note Clear your browser cache to ensure that you are allowed to view and resolve system reason code conflicts.

A Custom JR— pe—

The o i Salect the Reg o ragister. You will be prormp i adimin cradantisls: ‘

“iicaes requres s

510107

All conflicting reason codes are highlighted. To edit, select each conflicting reason code and click Edit. The
Edit Reason Code area appears. Select the reason code from the available options listed or enter any other
code you wish. The code must be unique to the particular category (Not Ready or Sign Out).

Ak Custom reixson codes conflict with system reason codes. Resolve 1o avoid reporfing neonsistency.

kianage Ressen Codes (ot Readh)

Lunch Break Custom 1000 Yos
Meeting Custom 1007 Yos
Coflee Break Custom 1002 Yos

Phone Failure Custom 12585 Yes

& Tnis reason coda already exists. Enter anather valus or choose from 15555, 15556 or 15557
Edit Rewson Code-

N P I pr— e .
[ ] coren | \”n)

Once resolved, the reason code gets sorted based on the reason code number and placed in the table accordingly.

510108

Wrap-Up Reasons

Wrap-Up reasons represent the reasons that agents can apply to calls. A Wrap-Up reason indicates why a
customer called the contact center. For example, you may have one Wrap-Up reason for sales calls and another
for support calls.

You can configure Wrap-Up reasons to be available globally to all agents or only to specific teams.

Use the Manage Wrap-Up Reasons gadget to view, add, edit, or delete Wrap-Up reasons. Click the Reason
Label header to sort the Wrap-Up reasons in ascending or descending order.

\}

Note Finesse supports a maximum of 100 global and 1500 team Wrap-Up reasons. No more than 100 Wrap-Up

reasons can be assigned to any one team.

\)

Note If an agent is configured for wrap-up and selects a pending state during a call, when the call finishes

that agent goes into the pending state selected during the call.
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The following table describes the fields on the Manage Wrap-Up Reasons gadget.

Field Explanation

Reason Label The label for the Wrap-Up reason.

This label must be unique for each Wrap-Up reason and has a maximum length of
39 bytes (which equals 39 US English characters). Both alphanumeric and special
characters are supported.

Global? Yes/No. Indicates if the Wrap-Up reason is available globally to all agents (Yes)
or to specific teams of agents (No).

Actions on the Manage Wrap-Up Reasons gadget:
* New: Add a new Wrap-Up reason

+ Edit: Edit an existing Wrap-Up reason
« Delete: Delete a Wrap-Up reason
* Refresh: Reload the list of Wrap-Up reasons from the server

\}

Note When you add, edit, or delete a Wrap-Up reason, the changes you make take effect on the agent or
supervisor desktop after three seconds. However, agents who are signed in when the changes are made
must sign out and sign back in to see those changes reflected on their desktops.

Add Wrap-Up Reason

Perform the following procedure to add a new Wrap-Up reason.
Procedure

Step 1 In the Manage Wrap-Up Reasons gadget, click New.
The New Wrap-Up Reason area appears.

Step 2 In the Reason Label field, add a label for the Wrap-Up reason.
Note Wrap-Up reason labels are limited to 39 bytes.

Step 3 If the Wrap-Up reason is global, select the Global? check box. If the Wrap-Up reason is specific to a team,
clear the Global? check box.

Note By default, the Global? check box is selected.

Step 4 Click Save.
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Edit Wrap-Up Reason

Step 1
Step 2

Step 3

Step 4

Edit Wrap-Up Reason .

Perform the following procedure to edit an existing Wrap-Up reason.

Procedure

In the Manage Wrap-Up Reasons gadget, select the Wrap-Up reason that you want to edit.
Click Edit.

The Edit Wrap-Up Reason area appears.

In the Wrap-Up Reason Label field, enter the new label for the Wrap-Up reason. If you want to change who
has access to the Wrap-Up reason, select or clear the Global? check box.

Click Save.

Delete Wrap-Up Reason

Step 1
Step 2

Step 3

Perform the following procedure to delete a Wrap-Up reason.

Procedure

In the Manage Wrap-Up Reasons gadget, select the Wrap-Up reason that you want to delete.
Click Delete.

A question appears asking you to confirm that you want to delete the selected Wrap-Up reason.

Click Yes to confirm the deletion of the selected Wrap-Up reason.

Manage Team Resources

Team Resources

You can assign phone books, reason codes, wrap-up reasons, custom desktop layouts, and workflows to teams
on the Team Resources tab of the administration console.

Use the Manage Team Resources gadget on the Team Resources tab to assign and unassign phone books,
reasons, custom desktop layouts, and workflows to teams. Click the Name or ID header to sort the teams in
ascending or descending order.
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The Manage Team Resources gadget contains six tabs, each enabling you to assign or unassign resources to
a team. The tabs are defined in the following table.

Tab Name Description

Desktop Layout Use this tab to customize the desktop layout for the team. The default layout is defined
in the Manage Desktop Layout gadget. You can define one custom layout for the
team.

Phone Books Use this tab to assign and unassign phone books to the team. Only phone books that

are defined in the Manage Phone Books gadget as available to teams are available
for assignment.

Reason Codes (Not | Use this tab to assign and unassign Not Ready reason codes to the team. Only Not
Ready) Ready reason codes that are defined in the Manage Reason Codes (Not Ready) gadget
as available to teams (not global) are available for assignment.

Reason Codes (Sign | Use this tab to assign and unassign Sign Out reason codes to the team. Only Sign
Out) Out reason codes that are defined in the Manage Reason Codes (Sign Out) gadget
as available to teams (not global) are available for assignment.

Wrap-Up Reasons Use this tab to assign and unassign Wrap-Up reasons to the team. Only Wrap-Up
reasons that are defined in the Manage Wrap-Up Reasons gadget as available to
teams (not global) are available for assignment.

Workflows Use this tab to assign and unassign workflows to the team. Only workflows that are
defined in the Manage Workflows gadget are available for assignment.

Actions on the Manage Team Resources Gadget

» Add: Assign a phone book, reason, or workflow to the team
» Save: Save the phone book, reason, desktop layout assignment, or workflow to the team

* Revert: Cancel any changes made before they are saved

371009
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» Refresh: Refresh the list of teams

N

Note If you select a team and then click Refresh, the team is deselected and the
Resources area for that team disappears. The list of teams is refreshed and
you must select a team again.

Add or Delete a Team When Database Is Not Accessible

If you add or delete a team when Finesse cannot access the Finesse database, those changes do not appear in
the Finesse administration console unless you restart Cisco Finesse Tomcat or the Cisco Unified CCX Engine.

Assign Phone Books and Reasons to Team

Procedure

Step 1 In the Manage Team Resources gadget, select a team.

Tabs for each available resource appear.

Step 2 Click the tab for the resource you want to assign for the selected team.

The List of <resource> area appears.

Step 3 Click Add.

The Add <resource> popup appears.

Step 4 Select one or more resources from the list to assign them to the team.

Resources you assign are highlighted in blue in the Add <resources> popup and added to the List of <resources>

area.
Step 5 When you has finished assigning resources, click Save.
Note You can make changes on all resource tabs and then save them at the same time. If there is an error

on one resource tab but not others, the changes on the tabs with no errors are saved while the changes
on the tab with errors are not saved.

Unassign Phone Books and Reasons from Team

Procedure

Step 1 In the Manage Team Resources gadget, select a team.

Tabs for each available resource appear.

Step 2 Click the tab for the resource you want to unassign from the selected team.
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The List of <resource> area appears.

Step 3 Click the red X next to the resource you want to unassign.
Step 4 Click Save.

Assign Custom Desktop Layout to Team

Perform the following procedure to create and assign a custom desktop layout to a team.

Procedure

Step 1 In the Manage Team Resources gadget, select a team.

Tabs for each available resource appear.

Step 2 Click the Desktop Layout tab.
The Desktop Layout XML area appears. The area contains the default desktop layout XML.

Step 3 Select the Override System Default check box.
The XML becomes editable.

Step 4 Edit the XML as desired.

Step 5 Click Save.

The custom desktop layout replaces the default desktop layout for the team after 10 seconds. If a supervisor
or agent is signed in when the change is saved, the change does not go into effect on their desktop until the
supervisor or agent signs out and signs in again.

Note If you clear the Override System Default check box, any changes you made to the XML are lost
and the XML in the editing pane reverts to the default desktop layout XML.

\)

Note If the Supervisor is managing single / multiple teams, the custom layout of the team for which he is a
resource / agent is displayed. However, if he is not a resource / agent of the team, the layout of the default
team is displayed.

Assign Workflows to Team

Procedure

Step 1 In the Manage Team Resources gadget, select a team.

Tabs for each available resource appear.

Step 2 Click the Workflows tab.
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Step 3

Step 4

Step 5

Step 6

Unassign Workflows from Team .

The List of Workflows area appears.

Click Add.
The Add Workflow popup appears.

Select one or more workflows from the list to assign them to the team.

Workflows you assign are highlighted in blue in the Add Workflows popup and added to the List of Workflows
area.

Workflows are executed in the order in which they are listed. Use the up and down arrows to move a selected
workflow to the desired position in the list.

When you has finished assigning workflows, click Save.
Note You can make changes on all resource tabs and then save them at the same time. If there is an error

on one resource tab but not others, the changes on the tabs with no errors are saved while the changes
on the tab with errors are not saved.

Unassign Workflows from Team

Step 1

Step 2

Step 3
Step 4

Procedure

In the Manage Team Resources gadget, select a team.

Tabs for each available resource appear.

Click the Workflows tab.
The List of Workflows area appears.

Click the red X next to the workflow you want to unassign.
Click Save.

Manage Workflows

On the Workflows tab of the Cisco Finesse administration console, you can create and manage workflows
and workflow actions.

Workflows and Workflow Actions

You can use workflows to automate common repetitive agent tasks. A workflow has a unique name and a
helpful description. Use the Manage Workflows and Manage Workflow Actions gadgets to view, add, edit,
or delete workflows and workflow actions.

All workflows are team-level workflows. You cannot create a global workflow. If you need a global workflow,
create a team workflow and assign it to all teams.

Finesse supports the following number of workflows and workflow actions:
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* 100 workflows per Finesse system
* 100 actions per Finesse system

* 20 workflows per team

* 5 conditions per workflow

* 5 actions per workflow

* 5 variables per action

Click the column headers to sort workflows and workflow actions in ascending or descending order.

The following table describes the fields on the Manage Workflows gadget.

Field Explanation

Name The name of the workflow. The name must be unique and can be a maximum
length of 40 characters.

Description The description of the workflow. The description can be a maximum length of
128 characters.

The following table describes the fields on the Manage Workflow Actions gadget.

Field Explanation

Name The name of the workflow action. The name must be unique and can be a maximum
length of 64 characters.

Type The type of workflow. Possible values are Browser Pop, HTTP Request.

Actions on the M anage Workflows and M anage Workflow Actions gadgets:

* New: Add a new workflow or workflow action

« Edit: Edit an workflow or workflow action

* Delete: Delete a workflow or workflow action

* Refresh: Reload the list of workflows or workflow actions from the server
You can configure workflow actions to be handled by the Finesse desktop or in a third-party gadget. A
third-party gadget can be designed to handle the action differently than Finesse does.

Each workflow must contain only one trigger. Triggers are based on Finesse dialog events. Dialog events
include the following:

* When a call arrives

* When a call is answered

\)

Note Ifyou set a workflow to trigger when a call is answered, the workflow runs
when an agent answers an incoming call or makes an outgoing call, or when
a customer answers an Outbound Option call.
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* When a call ends
* When making a call

» While previewing a Direct Preview Outbound call.

The workflow engine uses the following simple logic to determine whether to execute a workflow:

* To determine whether a workflow should execute, its trigger set and conditions are evaluated against
each dialog event received.

* The workflow engine processes workflow events for the first call that matches any configured workflow's
trigger set and conditions. No other workflows run until this call has ended. If the agent accepts a second
call while still on the first call, workflows do not run on the second call even after the first call has ended.

\}

Note Outbound Preview calls are an exception to this rule. You can have a
workflow run while the agent previews the call as well as when the agent
accepts the call.

» After a workflow for a particular trigger type (for example, Call Arrives) executes, it never triggers again
for the same dialog ID.

The workflow engine caches workflows for an agent when the agent signs in. Workflows do not change for
the agent until the agent signs out and signs in again or refreshes the browser.

)

Note Workflows that trigger when a call arrives, when a call is answered, or when making a call run whenever
the browser is refreshed. When an agent refreshes the browser, the workflow engine sees the call as
newly arrived or newly made. If an HTTP request action is part of the workflow, the HTTP request is
sent when the agent refreshes the browser. Applications that receive the HTTP requests must account
for this scenario. Otherwise, undesired results may occur.

An example of a workflow is a Call Arrival event that triggers an action that collects information from the
dialog event (for example, the ANI or customer information) and displays a web page containing customer
information.

You can filter trigger events by the value of the data that comes in the event. You can configure a workflow
to execute if any conditions are met or if all conditions are met.

Individual conditions consist of the following:
* A piece of event data to be examined, for example, DNIS or call variables

* A comparison between the event data and entered values (for example, contains, is equal to, is not equal
to, begins with, ends with, is empty, is not empty, and is in list)

When the trigger and its conditions are satisfied, a list of actions assigned to the workflow are executed. The
actions execute in the order in which they are listed.

Workflows run only for agents and supervisors who are Finesse users. The Workflow Engine is a JavaScript
library that runs client-side on a per-user basis within the Finesse desktop application. The desktop retrieves
the workflows to execute for a user from the server when the user signs in or refreshes the browser.
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\)

Note Changes made to a workflow or its actions while a user is signed in are not automatically pushed to that
user.

It is possible to set workflows, conditions, and actions that are contradictory so that a workflow or action
cannot function. Workflows are not validated.

If multiple workflows are configured for a team, the Workflow Engine evaluates them in the configured order.
The Workflow Engine ignores workflows with no actions. When the Workflow Engine finds a workflow with
a matching trigger for the event and the workflow conditions evaluate to true, then that workflow is the one
used and subsequent workflows in the list are not evaluated. Workflows with no conditions evaluate to true
if the event matches the workflow trigger. All workflows are enabled by default. Only one workflow for a
specific user can run at a time.

The Workflow Engine retrieves dialog-based variables used in workflow conditions from the dialog that
triggered the workflow. If a variable is not found in the dialog, then its value is assumed to be empty.

The Workflow Engine executes the actions associated with the matched workflow in the order in which they
are listed. The Workflow Engine executes actions in a workflow even if the previously executed action fails.
Failed actions are logged.

The Finesse server controls which calls are displayed to the Finesse user. If the user has multiple calls, the
workflow applies only to the first call that matches a trigger. If the first call displayed does not match any
triggers but the second call does match a trigger, the Workflow Engine evaluates and processes the triggers
for the second call.

A call is considered to be the first displayed call if it is the only call on the Finesse desktop when it appears.
If two calls on a phone are merged (as they are in a conference call), then the first displayed call flag value
of the surviving call is used.

If the user has a call when the user refreshes the browser, the Workflow Engine evaluates the call as it is. If
the dialog data (call variable values) change, the data may not match the trigger and conditions of the original
workflow. The data may match a different workflow or no workflows at all.

If the user has multiple calls when the user refreshes the browser, the Workflow Engine treats the first dialog
received from the Finesse server as the first displayed call. This call is not necessarily the same call that was
the first displayed call before the browser refresh. Dialogs received for any other call are ignored because
they are not considered first displayed calls. If dialogs for more than one call are received before the Workflow
Engine is loaded after the browser refresh, no dialogs are evaluated because none are considered first displayed
calls.

Workflows run for both Finesse agents and supervisors. The team to which the supervisor belongs (as
distinguished from the team that the supervisor manages) determines which workflows run for the supervisor.
You may want to put the supervisors in their own team to keep agent workflows from being run for them.

Workflow Triggers and Outhound Calls

)

Note When you create a workflow specifically for Outbound Option calls, add a condition of BAStatus is not
empty (except for the Workflow Trigger 'When a call arrives' as BAStatus will be empty at that point
of time). This condition ensures that the workflow can distinguish Outbound Option calls from
agent-initiated outbound calls.
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The following table illustrates when workflows trigger in outbound call scenarios.

Workflow Trigger

Direct Preview Outbhound Call

Progressive or Predictive Outhound
Call

While previewing a call

When the agent previews the call
(before the agent accepts or rejects
the call).

Does not trigger.

When a call arrives

When the agent accepts the call.

Does not trigger.

When a call is answered

‘When the customer answers the
call.

If the agent conferences in another
agent or transfers the call, the
workflow triggers for the agent
who is the recipient of the
conference or transfer.

When the customer answers the
call.

If the agent conferences in another
agent or transfers the call, the
workflow triggers for the agent
who is the recipient of the
conference or transfer.

When a call is made

When the customer call is
initiated.

When the customer call is initiated
or when failover occurs during the
call.

When a call ends

‘When the customer call ends.

When the customer call ends.

Add Browser Pop Workflow Action

The Browser Pop workflow action opens a browser window or tab on the user's desktop when workflow

Step 1

Step 2

Step 3
Step 4

Step 5

conditions are met.

\)

Note Whether the action opens a new window or tab on the desktop depends on the target user's browser

settings.

Procedure

In the Manage Workflow Actions gadget, click New.

The New Action area appears.

In the Name box, enter a name for the action.

Note Workflow action names are limited to 64 characters.

From the Type drop-down list, select Browser Pop.

From the Handled By drop-down list, select what will execute the action, either the Finesse Desktop or Other

(a third-party gadget).

In the Window Name box, enter the name that serves as the ID of the window that is opened. Any action that
uses this window name reuses that specific window.
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. Add HTTP Request Workflow Action

Step 6

Step 7

Note Window names are limited to 40 characters, and can be blank. If you leave the window name blank,
a new window opens every time the action runs.

Enter the URL of the browser window to open, and then click the tag icon at the right of the box and select
one or more variables from the drop-down list to add tags.

Example:

= 3 8
http:/fwww google.com/search?q=| callVariable 1 3 (& callVariable2 3 g

For every variable you select, you can enter test data in the Sample Data box. A sample URL is automatically
built in the Browser URL box below the Sample Data area. To test the URL, click Open to open the URL in
your browser.

Note Finesse does not validate the URL you enter.

Click Save.

Add HTTP Request Workflow Action

Step 1

Step 2

Step 3
Step 4

Step 5

Step 6

Step 7

Step 8

The HTTP Request workflow action makes an HTTP request to an API on behalf of the desktop user.

Procedure

In the Manage Workflow Actions area, click New.

The New Action area appears.

In the Name box, enter a name for the action.
A workflow action name can contain a maximum of 64 characters.

From the Type drop-down list, select HT TP Request.

From the Handled By drop-down list, select what will execute the action, the Finesse desktop or Other (a
third-party gadget).
From the Method drop-down list, select the method to use.

You can select either PUT or POST.

From the Location drop-down list, select the location.

If you are making the HTTP request to a Finesse API, select Finesse. If you are making a request to any other
API, select Other.

In the Content Type box, enter the content type.

The default content type is application/xml, which is the content type for Finesse APIs. If you are using a
different API, enter the content types for that API (for example, application/JSON).

In the URL box, enter the URL to which to make the request. To add variables to the URL, click the tag icon
at the right of the box and select one or more variables from the drop-down list.

Note The drop-down list contains variables from all the media channels.
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Example:
- o e 2
ffinesse/api/User/ dialogld % g

Note The preceding example is the URL for a Finesse API. If you want to make a request to another API,
you must enter the entire URL (for example, http://googleapis.com).

You can click the tag icon at the right of the box and select one or more variables from the drop-down list to
add tags to the URL. In the preceding example, to add the dialogld, click the tag icon and select dialogld from
the list.

Step 9 In the Body box, enter the text for the request. The body must match the content type (for example, if the
content types is application/xml, the body must contain XML. To add variables to the body, click the tag icon
at the right of the box and select one or more variables from the drop-down list.

Example:

To make an HTTP request to the Dialog - Start a recording API, enter the following into the Body box:
<Dialog=>

<requestedAction>START _RECORDING=/requestedAction>

<targetMediaAddress=| extension ¥ |</targetMediaAddress=>

=/Dialog= g

To add the extension, click the tag icon and select extension.

For every variable you add, you can enter test data in the Sample Data box.

Step 10 Click Save.

Edit Workflow Action
Procedure
Step 1 In the Manage Workflow Actions gadget, select the action that you want to edit.
Step 2 Click Edit.
The Edit Action area appears.
Step 3 Edit the fields that you want to change.
Step 4 Click Save.

Delete Workflow Action

Step 1

Procedure

In the Workflow Actions gadget, select the action that you want to delete.
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Step 2

Step 3

Add Workflow

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6
Step 7

Step 8
Step 9

Edit Workflow

Step 1

Cisco Finesse |

The Delete Action area appears.

Click Delete.

A question appears asking you to confirm that you want to delete the selected action.

Click Yesto confirm the deletion of the selected action.

Procedure

In the Manage Workflows gadget, click New.

The New Workflow area appears.

In the Name box, enter the name of the workflow.

Note The name is limited to 40 characters.

In the Description box, enter a description of the workflow.

Note The description is limited to 128 characters.

In the When to perform Actions drop-down list, select the event that triggers the workflow.

In the How to apply Conditions box, select if all conditions are met, or if any conditions are met, and then
click Add Condition to add up to five conditions.

Example:

For example, you can specify that the action is taken when CallVariable 1 is equal to 123 and CallVariable 2
begins with 2.

In the Ordered List of Actions area, click Add to open the Add Actions area. Click an action in this area to
add it to the Ordered List of Actions.

Use the up and down arrows next to the Ordered List of Actions to move actions into the order in which they
should be performed.

Click Save.

Assign the workflow to one or more teams.

Note A workflow does not run until it is assigned to a team.

Procedure

In the Manage Workflows gadget, select the workflow you want to edit.
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Delete Workflow .

Step 2 Click Edit.
The Edit Workflow area appears.
Step 3 Edit the fields that you want to change.
Step 4 Click Save.
Delete Workflow
Procedure
Step 1 In the Manage Workflows gadget, select the workflow that you want to delete.
The Delete Workflow area appears.
Step 2 Click Delete.
A question appears asking you to confirm that you want to delete the selected workflow.
Step 3 Click Yesto confirm the deletion of the selected workflow.

Manage Security

HSTS

The Cisco Finesse administration console and agent desktop support secure HTTP (HTTPS). To access the
administration console, enter the following URL in your browser (where FQDN is the fully qualified domain
name of your primary server):

https://FQDN:8445/cfadmin
Similarly, agents and supervisors can access their desktops as follows:
https://FQDN:8445/

For HTTPS access, you can eliminate browser security warnings by choosing to trust the self-signed certificate
provided with Finesse or uploading a CA certificate.

If you add custom gadgets that perform HTTPS requests to Finesse, you must add a certificate to the Finesse
server for that gadget.

\)

Note Wildcard Certificates are not supported in Unified CCX.

Finesse supports HTTP Strict Transport Security (HSTS) for increased security. HSTS is automatically enabled,
in which case the Finesse server sends HTTPS responses indicating to browsers that Finesse can only be
accessed using HTTPS. If users then try to access Finesse using HTTP instead of HTTPS, the browser changes
the connection to HTTPS before generating any network traffic. This functionality prevents browsers from
sending requests to Finesse using unencrypted HTTP before the server can redirect them.
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Manage Finesse IP Phone Agent

Finesse IP Phone Agent

With Finesse IP Phone Agent (IPPA), agents and supervisors can access Finesse features on their Cisco IP
Phones as an alternative to accessing Finesse through the browser. Finesse IPPA supports fewer features than
the Finesse desktop in the browser, but it does allow agents and supervisors to receive and manage Finesse
calls if they lose or do not have access to a computer.

Supervisor Tasks

Finesse IPPA does not support supervisor tasks such as monitor, barge, and intercept, but supervisors can
sign in and perform all agent tasks on their IP Phones.

Administration Tasks

After you configure Finesse IPPA, the administration tasks that you perform for the Finesse desktop also
apply for the supported Finesse IPPA features. For example, the Call Variables Layouts that you configure
for the desktop also apply for Finesse IPPA, although the column layout is modified to fit the IP Phone screen.

Reason Code Limitations

* On the IP Phone, Finesse can display a maximum of 100 Not Ready, Wrap Up, or Sign Out reason codes.
If more than 100 codes are configured, the phone lists the first 100 applicable codes (global codes or
applicable team codes).

» When Finesse IPPA displays reason codes, some IP Phone models truncate the codes due to character
length limitations on the phone. To ensure they meet your requirements, verify the display of the reason
codes on all phone models in your environment.

HTTP Only

Finesse IPPA phone clients communicate with the Finesse server using HTTP only, whether or not HTTPS
access is enabled on Finesse.

Failure Behavior

Unlike the Finesse desktop, the Finesse IP Phone Agent does not automatically failover to the alternate Finesse
server. To resume normal operations in a failure scenario, the Finesse IPPA agents must exit from the current
Finesse IP Phone service and manually sign in to another configured Finesse service that connects to an
alternate Finesse server.

To ensure continued operations in a failure situation, you must configure at least two Finesse IP Phone services
in Unified CM, each pointing to different Finesse servers.

One Button Sign In

With One Button Sign In, you can set up the Finesse IPPA phones with prepopulated agent ID, extension,
and password. In this case, agents can sign in to Finesse on the IP Phone without credentials just by selecting
Cisco Finesse from the Services menu.

Alternatively, you can set up One Button Sign In and prepopulate only a subset of agent credentials. For
example:
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* You can prepopulate only the agent ID and extension, forcing the agents to manually enter their password
at sign-in for increased security.

* You can prepopulate only the extension, forcing agents to manually enter their ID and password at sign-in
(useful for agents who share the same phone).
You can use Unified CM Administration to prepopulate the agent credentials, or you can set up the agents
with access to the Unified CM Self Care Portal to prepopulate their own credentials.

The following table shows examples of how you can assign the responsibility of defining agent credentials
to the administrator or the agent, or share that responsibility between them.

Example Set Up Prepopulated in Unified |Prepopulated in Self Care | Entered at Sign-In
CM Administration Portal
(by Agent)
(by Administrator) (by Agent)
Administrator populates| extension - id
the extension only
password
Administrator populates|id - password
the D and extension .
extension
Agentsenter password |id password -
only using Self Care extension
Portal
Agentsenter all - id -
credentials using Self extension
CarePortal
password
Agentsenter 1D and - id password
extension only using Self extension
CarePortal

Finesse IP Phone Service Subscription Options

To set up access to Finesse on agent IP phones in Cisco Unified Communications Manager, you must create
the Finesse IP Phone service to which the phones can subscribe. To set up the Finesse service, you can choose
one of the following options:

* Set up an enterprise subscription to automatically subscribe all IP phones in the cluster to the Finesse
service. (Not supported with One Button Sign In.)

* Set up a manual subscription, and manually subscribe each IP phone to the Finesse service.

* Set up a manual subscription, and set up the agents with access to the Unified CM Self Care Portal to
subscribe to the Finesse service themselves.

The following table lists the Finesse IPPA configuration procedures and indicates which procedures are
required depending on the subscription option you choose.
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Finesse IPPA Configuration
Procedures

Enterprise Subscription

Manual Subscription

Administrator Manually
Subscribes the Phones

Agents Manually Subscribe
Their Phones Using the Self
Care Portal

Set Up Application User, Web Required Required Required

Access, and HTTPS Server

Parameters, on page 64

Configure Finesse IP Phone Service | Required Required Required

in Unified CM, on page 65

One Button Sign In, on page 62 Not applicable Required only with One Button | Required only with One

Sign In Button Sign In

Subscribe Agent Phones to Manual | Not applicable
Subscription Service, on page 69

Required Optional. Allows the
administrator to enter agent
credentials for One Button

Sign In.

Set Up Agent Access to the Self
Care Portal, on page 70

Optional. Allows agents to enter
their own credentials for One
Button Sign In.

Not applicable Required

Set Up Application User, Web Access, and HTTPS Server Parameters

To support Finesse IPPA functionality, you must configure an application user in Unified Communications
Manager that is associated with all Finesse IPPA phones. And for proper Finesse IPPA operation, you must
also set the Web Access and HTTPS Server parameters in Unified CM.

These steps are required for both manual and enterprise subscriptions.

Before you begin

Set up call capabilities for the agent phones in Cisco Unified Communications Manager.

Procedure

Step 1 Set the following parameters in Unified CM:
* Set the Web Access parameter to Enabled.

* Set the HTTPS Server parameter to HTTP and HTTPS Enabled.

To set these parameters in Cisco Unified CM Administration, use either of the following pages:
* Phone Configuration page (Product Specific Configuration portion of page): choose Device > Phone.

* Enterprise Phone Configuration page: choose System > Enterprise Phone Configuration.

Step 2 Configure an application user in Unified Communications Manager.
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Step 3

a)
b)
<)

d)

g)

Configure Finesse IP Phone Service in Unified CM .

In Cisco Unified Communications Manager Administration, select User Management > Application
User.
Click Add New.

Under User Information, enter a user ID and password for the new user.

The password must be 95 characters or less and must contain ASCII characters only.

Under Device Information, in the Available Devices pane, select all phones that Finesse IP Phone Agents
will use and move them to the Controlled Devices pane using the arrows.
Under Permissions Information, click Add to Access Control Group.

From the list of search results, select Standard CT| Enabled and Standard CTI Allow Control Of All
Devices and then click Add Selected.

The application user is added to the Standard CTI Enabled and Standard CTI Allow Control Of All Devices
groups.

Click Save at the bottom of the page.

Note In UCCX deployments, usage of an existing RMCM User for Finesse IPPA is known to cause

problems in functionality, however, the physical phones must be associated with the RMCM User.

Enter the application user's credentials in the Finesse IP Phone Agent Settings gadget.

a)
b)

<)

d)
e)

Sign in to the Cisco Finesse Administration Console.

Choose Settings> | P Phone Agent Settings.

Under Phone URL Authentication Settings, enter the same username and password that you entered in
Unified CM for the application user.

The password must be 95 characters or less and must contain ASCII characters only.

Click Save.
Restart Cisco Finesse Tomcat on the primary Unified CCX node.
After replication is complete, restart Cisco Finesse Tomcat on the secondary Unified CCX node.

For information to check the replication status, see Step 3 of Prepare System for | P Addresshost name
Change.

Note For Finesse IP Phone Agent (FIPPA) from 11.0 (1) onwards, the User Device Profile (UDP) must

be associated with the FIPPA Application User along with the physical phones for agents using
Extension Mobility. The Finesse Service URL must use the complete FQDN of the UCCX server.

Related Topics

Prepare System for IP Address/hostname Change

Configure Finesse IP Phone Service in Unified CM

Step 1

Step 2

The following procedure describes the steps required for both manual and enterprise subscription.

Procedure

Log in to the Cisco Unified Communications Manager Administration using administrator credentials.
From the Communications Manager menu, select Device > Device Settings > Phone Services.
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. Configure Finesse IP Phone Service in Unified CM

Step 3
Step 4

Step 5

Step 6

Step 7
Step 8

On the IP Phone Services page, click Add New to create a new IP phone service.

In the Service Name field, enter Cisco Finesse (or another service name that is appropriate for your
environment).

In the Service URL field, enter:
http://Finesse FQDN:8082/fippa/#DEVICENAME#

where Finesse FQDN is the fully qualified domain name (FQDN) of your primary Finesse server.

Ensure that the Service Category is set to XML Service, and the Service Typeis set to Standard | P Phone
Service.

Check the Enable check box.

Do one of the following:

* To automatically subscribe all phones in the cluster to the Finesse service, check the Enterprise
Subscription check box, and click Save. Agents and supervisors can now access Cisco Finesse by
selecting it from the Services menu on subscribed IP phones.

Note One Button Sign In is not supported with enterprise subscriptions.

Figure 1: Finesse Service Configuration with Enterprise Subscription

ahalie  Cisco Unified CM Administration

cisco For Cisco Unified Communications Solutions

System = CallRoufing » Wedia Resources »  Advanced Features » Device «  Application «

IP Phone Services Configuration

B Save

— Status

@ Status: Ready

— Service Information
Service Name™® Cisca Finesse

Service Description  —izon Finesse

} *
Service URL http://finesse FQDN, hostname, or IP address=:<port>
Secure-Service URL

Service Category® XML Service -

Service Type® Standard IP Phone Service -

Service Vendor

Service Version

V| enable

] Enterprise Subseription

Saye]

!

* To subscribe only the desired phones to the Finesse service manually, leave the Enter prise Subscription
check box unchecked and click Save.
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Figure 2: Finesse Service Configuration Without Enterprise Subscription

Cisco

For Cisco Unified Communications Solutions

alialin  Cisco Unified CM Administration I

System « CallRoutng = Media Resources =  Advanced Features = Device = Applcation =

1P Phone Services Configuration
lg Save

r Status

@ Status: Ready

r Service Information

* ;
Sernvice Name Cisco Finesse

Service Descripbion  Cigco Finesse

Service URL* http://<finesse ip address or hostname or FQDN=:<por
Secure-Service URL

Service Category® XML Service -
Service Type® Standard [P Phone Service -

Servies Vendor
Service Version

Yl Enable
| Enterpnse Subscnption

[5@]

Step 9 With a two-node Finesse setup (primary and secondary Finesse servers), perform the preceding steps again
to create a secondary Finesse service that points to the secondary Finesse server. When you create the secondary
service, note the following procedural differences:

* At Step 4, in the Service Name field, enter a name that distinguishes the secondary service from the
primary service, such as Cisco Finesse Secondary.

* At Step 5, in the Service URL field, replace Finesse FQDN with the FQDN of the secondary server.

Note Since Finesse IPPA works only over HTTP, avoid using Secured Phone URL Parameters in Unified
CM.

Add Service Parameters for One Button Sign In

With One Button Sign In, for any agent credentials that you want prepopulated, you must set up corresponding
service parameters in Unified CM.

Only perform this procedure if you are setting up One Button Sign In. Otherwise, skip this procedure.
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Procedure

Cisco Finesse |

Step 1 From Cisco Unified Communications Manager Administration, select the Finesse phone service (under
Device > Device Settings > Phone Services).

Step 2 Click New to the right of the Parameters box.

The Configure Cisco IP Phone Service Parameter page displays.

Step 3 Set up service parameters for the agent id, extension, and password credentials in accordance with the following
table. Enter only the parameters that you want prepopulated for the agents. For each parameter, enter the
required field values and click Save. To add additional parameters, click Add New and enter the required

values.

Field

Description

Parameter Name

Enter one of the following parameter names as follows:
«1d
* extension

* password

The values entered are the exact query string parameters used for the subscription
URL.

Parameter Display
Name

Enter a descriptive parameter name; for example, id, extension, and password.

Default Value

Leave the default value blank for all parameters.

Parameter Description

Enter a description of the parameter. The user can access this text when they
subscribe to the service.

Parameter is Required

If the administrator will prepopulate the parameter in Unified CM Administration,
check the Parameter is Required check box.

However, if the agent will prepopulate the parameter in the Self Care Portal, two
options are available:

« If the agents will prepopulate all defined parameters, check the Parameter
is Required check box for each parameter.

« If the agent and administrator will share the responsibility of prepopulating
the parameters, set only the administrator-defined parameters as required.
This configuration ensures that the administrator can save the subscription
without prepopulating all parameters. In this case, the administrator first
prepopulates the required parameters, and then the agents prepopulate the
nonrequired parameters.

Parameter isa
Passwor d (mask
contents)

Check this check box for the password only.

This check box masks the password entries in the Self Care Portal, to display
asterisks rather than the user entry.

. Cisco Finesse



| Cisco Finesse

Subscribe Agent Phones to Manual Subscription Service .

When you save the last parameter, click Save and Close.

Configure Cisco TP Phone Service Parameter
Q Save ? Help

~Status

@ Status: Ready

—Service Parameter Information

Parameter Name™*

id

parameter Display Name*
id

Default Value

Parameter Description®
id

Clparameter is Reguired

| Parameter is a Password (mask contents)

Save | | Save And Close

What to do next

You can prepopulate the agent credentials when you subscribe the agent phones, or the agents can prepopulate
their own credentials using the Unified CM Self Care Portal.

Subscribe Agent Phones to Manual Subscription Service

Step 1
Step 2
Step 3

Step 4
Step 5
Step 6

Step 7

If you set up the Finesse service as a manual subscription, you can subscribe the agent phones to the Finesse
service in Unified CM and optionally define agent credentials for One Button Sign In.

If you prefer to allow the agents subscribe to the Finesse service using the Self Care Portal and prefer not to
specify One Button Sign In credentials for the agents, you can skip this procedure.

Procedure

From the menu bar, select Device > Phone.
Select the phone that you want to subscribe to the Finesse service.

From the Related Links drop-down list on the upper right side of the window, select Subscribe/Unsubscribe
Servicesand click Go.

The Subscribed I P phone services window displays for this phone.
From the Select a Service drop-down list, select Cisco Finesse.

Click Next.

(Applicablefor One Button Sgn In only) Enter values for any of the defined service parameters (id, password,
and extension) that you do not want the agents to enter using the Self Service Portal or at sign-in.

Click the Subscribe button to subscribe this phone to the Cisco Finesse service.
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. Set Up Agent Access to the Self Care Portal

Step 8

Step 9

The Cisco Finesse service displays in the Subscribed Services list.

Click Save.

The subscribed agents or supervisors can now access Cisco Finesse by selecting it from the Services menu
on their IP phones.

With a two-node Finesse setup (primary and secondary Finesse servers), perform this procedure again to also
subscribe the phones to the secondary Finesse service that points to the secondary Finesse server.

Set Up Agent Access to the Self Care Portal

Step 1
Step 2

Step 3
Step 4
Step 5
Step 6
Step 7

You can optionally set up the agents with access to the Unified CM Self Care Portal to prepopulate their own
credentials and to subscribe to the Finesse service.

If you are not setting up One Button Sign In, or not enabling the agents with access to the Self Care Portal,
skip this procedure.

Procedure

From the Unified CM Administration page, select System > Enterprise Parameters.

Under the Self Care Portal Parameters, in the Self Care Portal Default Server field, select the IP address of
the Unified CM Publisher server from the drop-down list and click Save.

Select User Management > End User.

Select the user that you want to set up with access to the User Care Portal.

Under Permissions Information, click Add to Access Control Group.

From the list of Access Control groups displayed, check Standard CCM End Usersand click Add Selected.
Click Save.

With access enabled to the Self Care Portal, agents can sign in to the portal at http://<UCM address>/ucmuser
to subscribe to the Finesse service and enter their own credentials under Phones> Phone Settings> Services.

)

Note In atwo-node Finesse setup with two services configured, the agents must enter their credentials on

both the primary and secondary Finesse services.

Backup and Restore

The Unified CCX backup and restore component also backs up and restores Finesse configurations and data.

For more information about backup and restore, see Cisco Unified Contact Center Express Administration
and Operations Guide at https://www.cisco.com/c/en/us/support/customer-collaboration/
unified-contact-center-express/products-maintenance-guides-list.html
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Additional Language Support

For the list of languages that are supported by Finesse, see the Unified CCX Compatibility related information,
located at:

https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/
products-device-support-tables-list.html.

If you want to use the Finesse desktop interface in a language other than English, download and install the
language COP file. For more information, see the “COP File” section of the Cisco Unified Contact Center
Express Install and Upgrade Guide, located at:

https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/
products-installation-guides-list.html.

Cisco Finesse Agent and Supervisor Desktop

Cisco Finesse Desktop provides easy access to the applications and information sources from a single
customizable cockpit. Providing this unique access to information helps the agents deliver fast and accurate
service.

For more information about Cisco Finesse Agent and Supervisor Desktop , see Cisco Finesse Agent and
Supervisor Desktop User Guide for Cisco Unified Contact Center Express at https://www.cisco.com/en/US/
products/sw/custcosw/ps1846/products user guide list.html.

Call Manager-Based Call Recording Using Cisco MediaSense

Cisco Finesse in Unified CCX supports call recording using Cisco MediaSense.
MediaSense is the media-capture platform for Cisco Unified Communications.
To use MediaSense, perform the following procedures:

Configure Cisco MediaSense with Unified CM, on page 71

Upload Cisco MediaSense Certificate to Unified CCX Server, on page 72
Upload MediaSense Recording License, on page 72

Configure MediaSense as a Recording Server, on page 73

Call Recording Through Workflow, on page 73

Configure MediaSense Search and Play Gadget, on page 74

o gk wbdpE

\)

Note  After performing all of the procedures, restart the Unified CCX server. In high availability deployment,
restart both of the nodes.

Configure Cisco MediaSense with Unified CM

For information about configuring Cisco MediaSense with Unified CM, see the "Unified CM provisioning
for Cisco MediaSense" section in the Installation and Administration Guide for Cisco MediaSense at
https://www.cisco.com/en/US/products/ps11389/prod_installation_guides_list.html.
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Upload Cisco MediaSense Certificate to Unified CCX Server

To establish connection with Cisco MediaSense securely, you must upload the Cisco MediaSense certificate
to Unified CCX server.

Step 1

Step 2

Procedure

Download the tomcat.pem certificate from the Cisco MediaSense server.

a)

b)

<)

d)

e)

Sign in to Cisco Unified Operating System Administration on the Cisco MediaSense host (https://host or
IP address/cmplatform/showHome.do, where host or |P address is the hostname or IP address of the
Cisco MediaSense server).

Select Security > Certificate Management.

The Certificate List screen appears.

Click Find.

A list of certificates appears.

In the Common Name column, click the link of the certificate you want to download.

Note The Certificate Name must be tomcat-trust and the Certificate Type must be trusts-cert. The
Certificate Details pop-up window appears.

Click Download .PEM File.
A pop-up window appears.
Select Save Fileradio button and Click OK.

The file gets saved on your system.

Upload the certificate to the designated Unified CCX server.

a)

b)
<)
d)
e)
f)

Sign in to Cisco Unified Operating System Administration on the primary Unified CCX node (http://host
or |P address/cmplatform, where host or |P address is the hostname or IP address of the Unified CCX
node).

Choose Security > Certificate Management.

Click Upload Certificate/Certificate Chain.

From the Certificate Name drop-down list, select tomcat-trust.

Click Browse and navigate to the tomcat.pem file that you downloaded in the previous step.

Click Upload File.

For more information about certificate management, see the Certificate Management Menu section of
the Cisco Unified Operating System Administration Guide, at https://www.cisco.com/en/US/products/sw/
custcosw/ps1846/products_installation and configuration guides_list.html.

Upload MediaSense Recording License

To use the MediaSense recording feature, you must purchase the Unified CCX recording license and upload
it to the Unified CCX server.
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For information about how to upload the license, see Upload Licenses.

Related Topics
Upload Licenses

Configure MediaSense as a Recording Server

For information about configuring MediaSense as a recording server, see Recor ding Configuration.

Related Topics
Recording Configuration

Call Recording Through Workflow

Use the HTTP Request action to invoke the Finesse Recording API after the call is answered.

Procedure

Step 1 Create an HTTP Request Recording action:
a) Inthe Manage Workflow Actions area, click New.
b) Inthe Name box, enter a name for the action.
¢) From the Type drop-down list, select HT TP Request.
d) From the Handled By drop-down list, select Finesse Desktop.
e) From the Method drop-down list, select PUT.
f) From the Location drop-down list, select Finesse.
g) In the Content Type box, enter application/xml.
h) Inthe URL box, enter the following:

/finesse/api/Dialog/
i) Click the tag icon at the right of the box and select dialogld to add it to the URL.
j) Inthe Body box, enter the following:

<Dialog=>

<requestedAction=START_RECORDING=/requestedAction=

=targetMediaAddress>| extension ® |</targetMediafddress=
</Dialog=

390214

To add the extension, click the tag icon and select extension.

Example:
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Step 2
Step 3

Step 4

Edit Action

Mame @ Start Recording Action
Type |HTTF Request |Z|
Handled by Finesse Deskiop |E|

Method | PUT [+]
Location |Finesse |E|
Content Type | applicationftmi

URL | ffinesse/api/Dialog/| dialogId®

Body | <Djalog= L
<requestedAction=START _RECORDING=/requestedAction:=
=targetMediaAddress=| extension¥® |</targethMediaAddress:>

</Dialog>

372949

Click Save to save workflow action.
Add a Call Answered Workflow that executes the HTTP Request Recording action that you created in the
previous step.

Note The Call Answered Workflow can be used to trigger an HTTP Request Recording action for inbound
calls, agent-initiated outbound calls, and Predictive, Progressive, and Direct Preview outbound calls.

Assign the workflow to the teams that you would like to record.

Configure MediaSense Search and Play Gadget

Step 1
Step 2
Step 3

Before you begin

In the MediaSense server, you must have already configured Unified CM, Cisco Finesse, and MediaSense
API.

Procedure

Sign in to the Cisco Finesse administration console.

Click the Desktop Layout tab.
Find the MediaSense tab and gadget in the layout XML. Update the layout according to the comments in the
layout.

<l--
The following Tab and Gadget are for MediaSense. They are *ONLY* supported with
MediaSense.
If you are not using MediaSense,then remove them. If you are using MediaSense and wish
to show
Recording Management, then do the following:
1) Remove these comments leaving the tab and gadget
2) Replace all instances of "my-mediasense-server" with the Fully Qualified Domain
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Name of your MediaSense Server.

IMPORTANT NOTE:
- In order for this Gadget to work, you must have performed all documented
prerequisite
steps.

<tab>
<id>manageRecordings</id>
<label>finesse.container.tabs.supervisor.manageRecordingslLabel</label>
<gadgets>

<gadget>https://my-mediasense-server:8440/ora/gadget/MediaSenseGadget.xml</gadget>

</gadgets>
</tab>
-—>
Note Replace all instances of my-mediasense-server with https://<Fully Qualified Domain Name
of your MediaSense Server>/ora/gadget/MediaSenseGadget.xml.
Example:

https://abcd-ef-ghl02.abc.com:8440/ora/gadget/MediaSenseGadget .xml

Step 4 Click Save.

Note The supervisor must log out and log in again to Cisco Finesse Supervisor Desktop to access
MediaSense.
Step 5 Sign in to Cisco Finesse desktop as a supervisor and confirm that MediaSense gadget is accessible.
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